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Getting Started

These 101 tutorials require no previous knowledge of Entity Framework (EF). They will take you step-by-step through creating a simple application that queries and saves data from a database.

Entity Framework can be used in a variety of different .NET applications. The following tutorials will get you started on the platform where you want to use EF.


Available Tutorials



	Getting Started on Full .NET (Console, WinForms, WPF, etc.)
	Console Application to New Database

	Console Application to Existing Database (Database First)





	Getting Started on ASP.NET 5
	ASP.NET 5 Application to New Database

	ASP.NET 5 Application to Existing Database (Database First)





	Getting Started on Universal Windows Platform

	Getting Started on OSX

	Getting Started on Linux
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Getting Started on Full .NET (Console, WinForms, WPF, etc.)

These 101 tutorials require no previous knowledge of Entity Framework (EF) or Visual Studio. They will take you step-by-step through creating a simple application that queries and saves data from a database.

Entity Framework can create a model based on an existing database, or create a database for you based on your model. The following tutorials will demonstrate both of these approaches using a Console Application. You can use the techniques learned in these tutorials in any application that targets Full .NET, including WPF and WinForms.


Available Tutorials



	Console Application to New Database

	Console Application to Existing Database (Database First)
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注解

This article uses EF 7.0.0-rc1 which is the latest pre-release available on NuGet.org. You can find nightly builds of the EF7 code base hosted on https://www.myget.org/F/aspnetvnext/ but we do not maintain up-to-date documentation for nightly builds.




Console Application to New Database

In this walkthrough, you will build a console application that performs basic data access against a Microsoft SQL Server database using Entity Framework. You will use migrations to create the database from your model.


In this article:


	Prerequisites
	Latest version of NuGet Package Manager





	Create a new project

	Install Entity Framework

	Create your model

	Create your database

	Use your model






小技巧

You can view this article’s sample [https://github.com/aspnet/EntityFramework.Docs/tree/master/docs/getting-started/full-dotnet/sample/EFGetStarted.ConsoleApp.NewDb] on GitHub.




Prerequisites

The following prerequisites are needed to complete this walkthrough:


	Visual Studio 2013 or Visual Studio 2015

	Latest version of NuGet Package Manager

	Latest version of Windows PowerShell [https://www.microsoft.com/en-us/download/details.aspx?id=40855]




Latest version of NuGet Package Manager

Installing EF7 requires an up-to-date version of NuGet Package Manager. You can install the latest version from Visual Studio Gallery. Make sure you restart Visual Studio after installing the update.


	NuGet Package Manager for Visual Studio 2015 [https://visualstudiogallery.msdn.microsoft.com/5d345edc-2e2d-4a9c-b73b-d53956dc458d]

	NuGet Package Manager for Visual Studio 2013 [https://visualstudiogallery.msdn.microsoft.com/4ec1526c-4a8c-4a84-b702-b21a8f5293ca]








Create a new project


	Open Visual Studio (this walkthrough uses 2015 but you can use any version from 2013 onwards)

	File ‣ New ‣ Project...

	From the left menu select Templates ‣ Visual C# ‣ Windows

	Select the Console Application project template

	Ensure you are targeting .NET Framework 4.5.1 or later

	Give the project a name and click OK






Install Entity Framework

To use EF7 you install the package for the database provider(s) you want to target. This walkthrough uses SQL Server. For a list of available providers see Database Providers.


	Tools ‣ NuGet Package Manager ‣ Package Manager Console

	Run Install-Package EntityFramework.MicrosoftSqlServer –Pre



Later in this walkthrough we will also be using some Entity Framework commands to maintain the database. So we will install the commands package as well.


	Run Install-Package EntityFramework.Commands –Pre






Create your model

Now it’s time to define a context and entity classes that make up your model.


	Project ‣ Add Class...

	Enter Model.cs as the name and click OK

	Replace the contents of the file with the following code




注解

Notice the OnConfiguring method (new in EF7) that is used to specify the provider to use and, optionally, other configuration too.



	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34
35
36
37
38
39
40
41
42
43
44
45
46

	using Microsoft.Data.Entity;
using System.Collections.Generic;

namespace EFGetStarted.ConsoleApp
{
    public class BloggingContext : DbContext
    {
        public DbSet<Blog> Blogs { get; set; }
        public DbSet<Post> Posts { get; set; }

        protected override void OnConfiguring(DbContextOptionsBuilder optionsBuilder)
        {
            // Visual Studio 2015 | Use the LocalDb 12 instance created by Visual Studio
            optionsBuilder.UseSqlServer(@"Server=(localdb)\mssqllocaldb;Database=EFGetStarted.ConsoleApp.NewDb;Trusted_Connection=True;");

            // Visual Studio 2013 | Use the LocalDb 11 instance created by Visual Studio
            // optionsBuilder.UseSqlServer(@"Server=(localdb)\v11.0;Database=EFGetStarted.ConsoleApp.NewDb;Trusted_Connection=True;");
        }

        protected override void OnModelCreating(ModelBuilder modelBuilder)
        {
            // Make Blog.Url required
            modelBuilder.Entity<Blog>()
                .Property(b => b.Url)
                .IsRequired();
        }
    }

    public class Blog
    {
        public int BlogId { get; set; }
        public string Url { get; set; }

        public List<Post> Posts { get; set; }
    }

    public class Post
    {
        public int PostId { get; set; }
        public string Title { get; set; }
        public string Content { get; set; }

        public int BlogId { get; set; }
        public Blog Blog { get; set; }
    }
}








小技巧

In a real application you would typically put each class from your model in a separate file. For the sake of simplicity, we are putting all the classes in one file for this tutorial.






Create your database

Now that you have a model, you can use migrations to create a database for you.


	Tools –> NuGet Package Manager –> Package Manager Console

	Run Add-Migration MyFirstMigration to scaffold a migration to create the initial set of tables for your model.

	Run Update-Database to apply the new migration to the database. Because your database doesn’t exist yet, it will be created for you before the migration is applied.




小技巧

If you make future changes to your model, you can use the Add-Migration command to scaffold a new migration to make the corresponding schema changes to the database. Once you have checked the scaffolded code (and made any required changes), you can use the Update-Database command to apply the changes to the database.

EF uses a __EFMigrationsHistory table in the database to keep track of which migrations have already been applied to the database.






Use your model

You can now use your model to perform data access.


	Open Program.cs

	Replace the contents of the file with the following code



	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24

	using System;

namespace EFGetStarted.ConsoleApp
{
    class Program
    {
        static void Main(string[] args)
        {
            using (var db = new BloggingContext())
            {
                db.Blogs.Add(new Blog { Url = "http://blogs.msdn.com/adonet" });
                var count = db.SaveChanges();
                Console.WriteLine("{0} records saved to database", count);

                Console.WriteLine();
                Console.WriteLine("All blogs in database:");
                foreach (var blog in db.Blogs)
                {
                    Console.WriteLine(" - {0}", blog.Url);
                }
            }
        }
    }
}








	Debug ‣ Start Without Debugging



You will see that one blog is saved to the database and then the details of all blogs are printed to the console.

[image: ../../_images/output-new-db.png]
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注解

This article uses EF 7.0.0-rc1 which is the latest pre-release available on NuGet.org. You can find nightly builds of the EF7 code base hosted on https://www.myget.org/F/aspnetvnext/ but we do not maintain up-to-date documentation for nightly builds.




Console Application to Existing Database (Database First)

In this walkthrough, you will build a console application that performs basic data access against a Microsoft SQL Server database using Entity Framework. You will use reverse engineering to create an Entity Framework model based on an existing database.


In this article:


	Prerequisites
	Latest version of NuGet Package Manager

	Blogging database





	Create a new project

	Install Entity Framework

	Reverse engineer your model
	Entity Classes

	Derived Context





	Use your model






小技巧

You can view this article’s sample [https://github.com/aspnet/EntityFramework.Docs/tree/master/docs/getting-started/full-dotnet/sample/EFGetStarted.ConsoleApp.ExistingDb] on GitHub.




Prerequisites

The following prerequisites are needed to complete this walkthrough:


	Visual Studio 2013 or Visual Studio 2015

	Latest version of NuGet Package Manager

	Latest version of Windows PowerShell [https://www.microsoft.com/en-us/download/details.aspx?id=40855]

	Blogging database




Latest version of NuGet Package Manager

Installing EF7 requires an up-to-date version of NuGet Package Manager. You can install the latest version from Visual Studio Gallery. Make sure you restart Visual Studio after installing the update.


	NuGet Package Manager for Visual Studio 2015 [https://visualstudiogallery.msdn.microsoft.com/5d345edc-2e2d-4a9c-b73b-d53956dc458d]

	NuGet Package Manager for Visual Studio 2013 [https://visualstudiogallery.msdn.microsoft.com/4ec1526c-4a8c-4a84-b702-b21a8f5293ca]






Blogging database

This tutorial uses a Blogging database on your LocalDb instance as the existing database.


注解

If you have already created the Blogging database as part of another tutorial, you can skip these steps.




	Tools ‣ Connect to Database...

	Select Microsoft SQL Server and click Continue

	Enter (localdb)\mssqllocaldb as the Server Name

	Enter master as the Database Name

	The master database is now displayed under Data Connections in Server Explorer

	Right-click on the database in Server Explorer and select New Query

	Copy the script, listed below, into the query editor

	Right-click on the query editor and select Execute



	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28

	CREATE DATABASE [Blogging]
GO

USE [Blogging]
GO

CREATE TABLE [Blog] (
    [BlogId] int NOT NULL IDENTITY,
    [Url] nvarchar(max) NOT NULL,
    CONSTRAINT [PK_Blog] PRIMARY KEY ([BlogId])
);
GO

CREATE TABLE [Post] (
    [PostId] int NOT NULL IDENTITY,
    [BlogId] int NOT NULL,
    [Content] nvarchar(max),
    [Title] nvarchar(max),
    CONSTRAINT [PK_Post] PRIMARY KEY ([PostId]),
    CONSTRAINT [FK_Post_Blog_BlogId] FOREIGN KEY ([BlogId]) REFERENCES [Blog] ([BlogId]) ON DELETE CASCADE
);
GO

INSERT INTO [Blog] (Url) VALUES 
('http://blogs.msdn.com/dotnet'), 
('http://blogs.msdn.com/webdev'), 
('http://blogs.msdn.com/visualstudio')
GO












Create a new project


	Open Visual Studio (this walkthrough uses 2015 but you can use any version from 2013 onwards)

	File ‣ New ‣ Project...

	From the left menu select Templates ‣ Visual C# ‣ Windows

	Select the Console Application project template

	Ensure you are targeting .NET Framework 4.5.1 or later

	Give the project a name and click OK






Install Entity Framework

To use EF7 you install the package for the database provider(s) you want to target. This walkthrough uses SQL Server. For a list of available providers see Database Providers.


	Tools ‣ NuGet Package Manager ‣ Package Manager Console

	Run Install-Package EntityFramework.MicrosoftSqlServer –Pre



To enable reverse engineering from an existing database we need to install a couple of other packages too.


	Run Install-Package EntityFramework.Commands –Pre

	Run Install-Package EntityFramework.MicrosoftSqlServer.Design –Pre






Reverse engineer your model

Now it’s time to create the EF model based on your existing database.


	Tools –> NuGet Package Manager –> Package Manager Console

	Run the following command to create a model from the existing database



Scaffold-DbContext -provider EntityFramework.MicrosoftSqlServer -connection "Server=(localdb)\mssqllocaldb;Database=Blogging;Trusted_Connection=True;"





The reverse engineer process created entity classes and a derived context based on the schema of the existing database.


Entity Classes

The entity classes are simple C# objects that represent the data you will be querying and saving.

	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17
18

	using System;
using System.Collections.Generic;

namespace EFGetStarted.ConsoleApp.ExistingDb
{
    public partial class Blog
    {
        public Blog()
        {
            Post = new HashSet<Post>();
        }

        public int BlogId { get; set; }
        public string Url { get; set; }

        public virtual ICollection<Post> Post { get; set; }
    }
}










Derived Context

The context represents a session with the database and allows you to query and save instances of the entity classes.


注解

Notice the OnConfiguring method (new in EF7) that is used to specify the provider to use and, optionally, other configuration too.



	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29

	using Microsoft.Data.Entity;
using Microsoft.Data.Entity.Metadata;

namespace EFGetStarted.ConsoleApp.ExistingDb
{
    public partial class BloggingContext : DbContext
    {
        protected override void OnConfiguring(DbContextOptionsBuilder options)
        {
            options.UseSqlServer(@"Server=(localdb)\mssqllocaldb;Database=Blogging;Trusted_Connection=True;");
        }

        protected override void OnModelCreating(ModelBuilder modelBuilder)
        {
            modelBuilder.Entity<Blog>(entity =>
            {
                entity.Property(e => e.Url).IsRequired();
            });

            modelBuilder.Entity<Post>(entity =>
            {
                entity.HasOne(d => d.Blog).WithMany(p => p.Post).HasForeignKey(d => d.BlogId);
            });
        }

        public virtual DbSet<Blog> Blog { get; set; }
        public virtual DbSet<Post> Post { get; set; }
    }
}












Use your model

You can now use your model to perform data access.


	Open Program.cs

	Replace the contents of the file with the following code



	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24

	using System;

namespace EFGetStarted.ConsoleApp.ExistingDb
{
    class Program
    {
        static void Main(string[] args)
        {
            using (var db = new BloggingContext())
            {
                db.Blog.Add(new Blog { Url = "http://blogs.msdn.com/adonet" });
                var count = db.SaveChanges();
                Console.WriteLine("{0} records saved to database", count);

                Console.WriteLine();
                Console.WriteLine("All blogs in database:");
                foreach (var blog in db.Blog)
                {
                    Console.WriteLine(" - {0}", blog.Url);
                }
            }
        }
    }
}








	Debug ‣ Start Without Debugging



You will see that one blog is saved to the database and then the details of all blogs are printed to the console.

[image: ../../_images/output-existing-db.png]
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Getting Started on ASP.NET 5

These 101 tutorials require no previous knowledge of Entity Framework (EF) or Visual Studio. They will take you step-by-step through creating a simple application that queries and saves data from a database.

Entity Framework can create a model based on an existing database, or create a database for you based on your model. The following tutorials will demonstrate both of these approaches using an ASP.NET 5 application.


Available Tutorials



	ASP.NET 5 Application to New Database

	ASP.NET 5 Application to Existing Database (Database First)
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注解

This article uses EF 7.0.0-rc1 which is the latest pre-release available on NuGet.org. You can find nightly builds of the EF7 code base hosted on https://www.myget.org/F/aspnetvnext/ but we do not maintain up-to-date documentation for nightly builds.




ASP.NET 5 Application to New Database

In this walkthrough, you will build an ASP.NET 5 MVC application that performs basic data access using Entity Framework. You will use migrations to create the database from your model.


In this article:


	Prerequisites

	Create a new project

	Install Entity Framework

	Create your model

	Register your context with dependency injection

	Create your database

	Create a controller

	Create views

	Run the application






小技巧

You can view this article’s sample [https://github.com/aspnet/EntityFramework.Docs/tree/master/docs/getting-started/aspnet5/sample] on GitHub.




Prerequisites

The following prerequisites are needed to complete this walkthrough:



	Visual Studio 2015

	ASP.NET 5 RC1 Tools for Visual Studio [https://docs.asp.net/en/latest/getting-started/installing-on-windows.html]









Create a new project



	Open Visual Studio 2015

	File ‣ New ‣ Project...

	From the left menu select Templates ‣ Visual C# ‣ Web

	Select the ASP.NET Web Application project template

	Ensure you are targeting .NET 4.5.1 or later

	Enter EFGetStarted.AspNet5.NewDb as the name and click OK

	Wait for the New ASP.NET Project dialog to appear

	Under ASP.NET 5 Preview Templates select Web Application

	Ensure that Authentication is set to No Authentication

	Click OK







警告

If you use Individual User Accounts instead of None for Authentication then an Entity Framework model will be added to your project in Models\IdentityModel.cs. Using the techniques you will learn in this walkthrough, you can chose to add a second model, or extend this existing model to contain your entity classes.






Install Entity Framework

To use EF7 you install the package for the database provider(s) you want to target. This walkthrough uses SQL Server. For a list of available providers see Database Providers.



	Tools ‣ NuGet Package Manager ‣ Package Manager Console

	Run Install-Package EntityFramework.MicrosoftSqlServer –Pre







注解

In ASP.NET 5 projects the Install-Package will complete quickly and the package installation will occur in the background. You will see (Restoring...) appear next to References in Solution Explorer while the install occurs.



Later in this walkthrough we will also be using some Entity Framework commands to maintain the database. So we will install the commands package as well.



	Run Install-Package EntityFramework.Commands –Pre

	Open project.json

	Locate the commands section and add the ef command as shown below






	1
2
3
4
5

	  "commands": {
    "web": "Microsoft.AspNet.Server.Kestrel",
    "ef": "EntityFramework.Commands"
  },











Create your model

Now it’s time to define a context and entity classes that make up your model.



	Right-click on the project in Solution Explorer and select Add ‣ New Folder

	Enter Models as the name of the folder

	Right-click on the Models folder and select Add ‣ New Item...

	From the left menu select Installed ‣ Server-side

	Select the Class item template

	Enter Model.cs as the name and click OK

	Replace the contents of the file with the following code






	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34
35
36
37

	using Microsoft.Data.Entity;
using System.Collections.Generic;

namespace EFGetStarted.AspNet5.NewDb.Models
{
    public class BloggingContext : DbContext
    {
        public DbSet<Blog> Blogs { get; set; }
        public DbSet<Post> Posts { get; set; }

        protected override void OnModelCreating(ModelBuilder modelBuilder)
        {
            // Make Blog.Url required
            modelBuilder.Entity<Blog>()
                .Property(b => b.Url)
                .IsRequired();
        }
    }

    public class Blog
    {
        public int BlogId { get; set; }
        public string Url { get; set; }

        public List<Post> Posts { get; set; }
    }

    public class Post
    {
        public int PostId { get; set; }
        public string Title { get; set; }
        public string Content { get; set; }

        public int BlogId { get; set; }
        public Blog Blog { get; set; }
    }
}








注解

In a real application you would typically put each class from your model in a separate file. For the sake of simplicity, we are putting all the classes in one file for this tutorial.






Register your context with dependency injection

The concept of dependency injection is central to ASP.NET 5. Services (such as BloggingContext) are registered with dependency injection during application startup. Components that require these services (such as your MVC controllers) are then provided these services via constructor parameters or properties. For more information on dependency injection see the Dependency Injection [http://docs.asp.net/en/latest/fundamentals/dependency-injection.html] article on the ASP.NET site.

In order for our MVC controllers to make use of BloggingContext we are going to register it as a service.



	Open Startup.cs

	Add the following using statements at the start of the file






	1
2

	using EFGetStarted.AspNet5.NewDb.Models;
using Microsoft.Data.Entity;







Now we can use the AddDbContext method to register it as a service.



	Locate the ConfigureServices method

	Add the lines that are highlighted in the following code






	1
2
3
4
5
6
7
8

	        // This method gets called by the runtime. Use this method to add services to the container.
        public void ConfigureServices(IServiceCollection services)
        {
            var connection = @"Server=(localdb)\mssqllocaldb;Database=EFGetStarted.AspNet5.NewDb;Trusted_Connection=True;";

            services.AddEntityFramework()
                .AddSqlServer()
                .AddDbContext<BloggingContext>(options => options.UseSqlServer(connection));










Create your database


警告

The migrations experience in ASP.NET 5 is still a work-in-progress. The following steps are overly complex and will be simplified by the time we reach a stable release.



Now that you have a model, you can use migrations to create a database for you.



	Open a command prompt (Windows Key + R, type cmd, click OK)

	Use the cd command to navigate to the project directory

	Run dnvm use 1.0.0-rc1-final

	Run dnx ef migrations add MyFirstMigration to scaffold a migration to create the initial set of tables for your model.

	Run dnx ef database update to apply the new migration to the database. Because your database doesn’t exist yet, it will be created for you before the migration is applied.







小技巧

If you make future changes to your model, you can use the dnx ef migrations add command to scaffold a new migration to apply the corresponding changes to the database. Once you have checked the scaffolded code (and made any required changes), you can use the dnx ef database update command to apply the changes to the database.






Create a controller

Next, we’ll add an MVC controller that will use EF to query and save data.



	Right-click on the Controllers folder in Solution Explorer and select Add ‣ New Item...

	From the left menu select Installed ‣ Server-side

	Select the Class item template

	Enter BlogsController.cs as the name and click OK

	Replace the contents of the file with the following code






	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34
35
36
37
38
39
40
41

	using EFGetStarted.AspNet5.NewDb.Models;
using Microsoft.AspNet.Mvc;
using System.Linq;

namespace EFGetStarted.AspNet5.NewDb.Controllers
{
    public class BlogsController : Controller
    {
        private BloggingContext _context;

        public BlogsController(BloggingContext context)
        {
            _context = context;
        }

        public IActionResult Index()
        {
            return View(_context.Blogs.ToList());
        }

        public IActionResult Create()
        {
            return View();
        }

        [HttpPost]
        [ValidateAntiForgeryToken]
        public IActionResult Create(Blog blog)
        {
            if (ModelState.IsValid)
            {
                _context.Blogs.Add(blog);
                _context.SaveChanges();
                return RedirectToAction("Index");
            }

            return View(blog);
        }

    }
}







You’ll notice that the controller takes a BlogContext as a constructor parameter. ASP.NET dependency injection will take care of passing an instance of BlogContext into your controller.

The controller contains an Index action, which displays all blogs in the database, and a Create action, which inserts a new blogs into the database.




Create views

Now that we have a controller it’s time to add the views that will make up the user interface.

We’ll start with the view for our Index action, that displays all blogs.



	Right-click on the Views folder in Solution Explorer and select Add ‣ New Folder

	Enter Blogs as the name of the folder

	Right-click on the Blogs folder and select Add ‣ New Item...

	From the left menu select Installed ‣ Server-side

	Select the MVC View Page item template

	Enter Index.cshtml as the name and click OK

	Replace the contents of the file with the following code






	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30

	@model IEnumerable<EFGetStarted.AspNet5.NewDb.Models.Blog>

@{
    ViewBag.Title = "Blogs";
}

<h2>Blogs</h2>

<p>
    <a asp-controller="Blogs" asp-action="Create">Create New</a>
</p>

<table class="table">
    <tr>
        <th>Id</th>
        <th>Url</th>
    </tr>

    @foreach (var item in Model)
    {
        <tr>
            <td>
                @Html.DisplayFor(modelItem => item.BlogId)
            </td>
            <td>
                @Html.DisplayFor(modelItem => item.Url)
            </td>
        </tr>
    }
</table>







We’ll also add a view for the Create action, which allows the user to enter details for a new blog.



	Right-click on the Blogs folder and select Add ‣ New Item...

	From the left menu select Installed ‣ ASP.NET 5

	Select the MVC View Page item template

	Enter Create.cshtml as the name and click OK

	Replace the contents of the file with the following code






	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25

	@model EFGetStarted.AspNet5.NewDb.Models.Blog

@{
    ViewBag.Title = "New Blog";
}

<h2>@ViewData["Title"]</h2>

<form asp-controller="Blogs" asp-action="Create" method="post" class="form-horizontal" role="form">
    <div class="form-horizontal">
        <div asp-validation-summary="ValidationSummary.All" class="text-danger"></div>
        <div class="form-group">
            <label asp-for="Url" class="col-md-2 control-label"></label>
            <div class="col-md-10">
                <input asp-for="Url" class="form-control" />
                <span asp-validation-for="Url" class="text-danger"></span>
            </div>
        </div>
        <div class="form-group">
            <div class="col-md-offset-2 col-md-10">
                <input type="submit" value="Create" class="btn btn-default" />
            </div>
        </div>
    </div>
</form>










Run the application

You can now run the application to see it in action.



	Debug ‣ Start Without Debugging

	The application will build and open in a web browser

	Navigate to /Blogs

	Click Create New

	Enter a Url for the new blog and click Create
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警告

This documentation is for EF7 onwards. For EF6.x and earlier release see http://msdn.com/data/ef.
本文档是基于EF7版本.对于EF6.x及更早的版本请参见 http://msdn.com/data/ef.




注解

This article uses EF 7.0.0-rc1 which is the latest pre-release available on NuGet.org. You can find nightly builds of the EF7 code base hosted on https://www.myget.org/F/aspnetvnext/ but we do not maintain up-to-date documentation for nightly builds.




ASP.NET 5 Application to Existing Database (Database First)

In this walkthrough, you will build an ASP.NET 5 MVC application that performs basic data access using Entity Framework.  You will use reverse engineering to create an Entity Framework model based on an existing database.


In this article:


	Prerequisites
	Blogging database





	Create a new project

	Install Entity Framework

	Reverse engineer your model
	Entity Classes

	Derived Context





	Register your context with dependency injection
	Remove inline context configuration

	Register and configure your context in Startup.cs





	Create a controller

	Create views

	Run the application






小技巧

You can view this article’s sample [https://github.com/aspnet/EntityFramework.Docs/tree/master/docs/getting-started/aspnet5/sample] on GitHub.




Prerequisites

The following prerequisites are needed to complete this walkthrough:



	Visual Studio 2015

	ASP.NET 5 RC1 Tools for Visual Studio [https://docs.asp.net/en/latest/getting-started/installing-on-windows.html]

	Blogging database







Blogging database

This tutorial uses a Blogging database on your LocalDb instance as the existing database.


注解

If you have already created the Blogging database as part of another tutorial, you can skip these steps.




	Tools ‣ Connect to Database...

	Select Microsoft SQL Server and click Continue

	Enter (localdb)\mssqllocaldb as the Server Name

	Enter master as the Database Name

	The master database is now displayed under Data Connections in Server Explorer

	Right-click on the database in Server Explorer and select New Query

	Copy the script, listed below, into the query editor

	Right-click on the query editor and select Execute



	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28

	CREATE DATABASE [Blogging]
GO

USE [Blogging]
GO

CREATE TABLE [Blog] (
    [BlogId] int NOT NULL IDENTITY,
    [Url] nvarchar(max) NOT NULL,
    CONSTRAINT [PK_Blog] PRIMARY KEY ([BlogId])
);
GO

CREATE TABLE [Post] (
    [PostId] int NOT NULL IDENTITY,
    [BlogId] int NOT NULL,
    [Content] nvarchar(max),
    [Title] nvarchar(max),
    CONSTRAINT [PK_Post] PRIMARY KEY ([PostId]),
    CONSTRAINT [FK_Post_Blog_BlogId] FOREIGN KEY ([BlogId]) REFERENCES [Blog] ([BlogId]) ON DELETE CASCADE
);
GO

INSERT INTO [Blog] (Url) VALUES 
('http://blogs.msdn.com/dotnet'), 
('http://blogs.msdn.com/webdev'), 
('http://blogs.msdn.com/visualstudio')
GO












Create a new project



	Open Visual Studio 2015

	File ‣ New ‣ Project...

	From the left menu select Templates ‣ Visual C# ‣ Web

	Select the ASP.NET Web Application project template

	Ensure you are targeting .NET 4.5.1 or later

	Enter EFGetStarted.AspNet5.ExistingDb as the name and click OK

	Wait for the New ASP.NET Project dialog to appear

	Under ASP.NET 5 Preview Templates select Web Application

	Ensure that Authentication is set to No Authentication

	Click OK









Install Entity Framework

To use EF7 you install the package for the database provider(s) you want to target. This walkthrough uses SQL Server. For a list of available providers see Database Providers.



	Tools ‣ NuGet Package Manager ‣ Package Manager Console

	Run Install-Package EntityFramework.MicrosoftSqlServer –Pre







注解

In ASP.NET 5 projects the Install-Package will complete quickly and the package installation will occur in the background. You will see (Restoring...) appear next to References in Solution Explorer while the install occurs.



To enable reverse engineering from an existing database we need to install a couple of other packages too.



	Run Install-Package EntityFramework.Commands –Pre

	Run Install-Package EntityFramework.MicrosoftSqlServer.Design –Pre

	Open project.json

	Locate the commands section and add the ef command as shown below






	1
2
3
4

	  "commands": {
    "web": "Microsoft.AspNet.Server.Kestrel",
    "ef": "EntityFramework.Commands"
  },










Reverse engineer your model


警告

The reverse engineer experience in ASP.NET 5 is still a work-in-progress. The following steps are overly complex and will be simplified by the time we reach a stable release.



Now it’s time to create the EF model based on your existing database.



	Open a command prompt (Windows Key + R, type cmd, click OK)

	Use the cd command to navigate to the project directory

	Run dnvm use 1.0.0-rc1-update1

	Run the following command to create a model from the existing database






dnx ef dbcontext scaffold "Server=(localdb)\mssqllocaldb;Database=Blogging;Trusted_Connection=True;" EntityFramework.MicrosoftSqlServer --outputDir Models





The reverse engineer process created entity classes and a derived context based on the schema of the existing database. These classes were created in a Models folder in your project.


Entity Classes

The entity classes are simple C# objects that represent the data you will be querying and saving.

	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17
18

	using System;
using System.Collections.Generic;

namespace EFGetStarted.AspNet5.ExistingDb.Models
{
    public partial class Blog
    {
        public Blog()
        {
            Post = new HashSet<Post>();
        }

        public int BlogId { get; set; }
        public string Url { get; set; }

        public virtual ICollection<Post> Post { get; set; }
    }
}










Derived Context

The context represents a session with the database and allows you to query and save instances of the entity classes.

	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29

	using Microsoft.Data.Entity;
using Microsoft.Data.Entity.Metadata;

namespace EFGetStarted.AspNet5.ExistingDb.Models
{
    public partial class BloggingContext : DbContext
    {
        protected override void OnConfiguring(DbContextOptionsBuilder options)
        {
            options.UseSqlServer(@"Server=(localdb)\mssqllocaldb;Database=Blogging;Trusted_Connection=True;");
        }

        protected override void OnModelCreating(ModelBuilder modelBuilder)
        {
            modelBuilder.Entity<Blog>(entity =>
            {
                entity.Property(e => e.Url).IsRequired();
            });

            modelBuilder.Entity<Post>(entity =>
            {
                entity.HasOne(d => d.Blog).WithMany(p => p.Post).HasForeignKey(d => d.BlogId);
            });
        }

        public virtual DbSet<Blog> Blog { get; set; }
        public virtual DbSet<Post> Post { get; set; }
    }
}












Register your context with dependency injection

The concept of dependency injection is central to ASP.NET 5. Services (such as BloggingContext) are registered with dependency injection during application startup. Components that require these services (such as your MVC controllers) are then provided these services via constructor parameters or properties. For more information on dependency injection see the Dependency Injection [http://docs.asp.net/en/latest/fundamentals/dependency-injection.html] article on the ASP.NET site.


Remove inline context configuration

In ASP.NET 5, configuration is generally performed in Startup.cs. To conform to this pattern, we will move configuration of the database provider to Startup.cs.



	Open ModelsBlogginContext.cs

	Delete the lines of code highligted below






	1
2
3
4
5
6
7
8

	    public partial class BloggingContext : DbContext
    {
        protected override void OnConfiguring(DbContextOptionsBuilder options)
        {
            options.UseSqlServer(@"Server=(localdb)\mssqllocaldb;Database=Blogging;Trusted_Connection=True;");
        }

        protected override void OnModelCreating(ModelBuilder modelBuilder)










Register and configure your context in Startup.cs

In order for our MVC controllers to make use of BloggingContext we are going to register it as a service.



	Open Startup.cs

	Add the following using statements at the start of the file






	1
2

	using EFGetStarted.AspNet5.ExistingDb.Models;
using Microsoft.Data.Entity;







Now we can use the AddDbContext method to register it as a service.



	Locate the ConfigureServices method

	Add the lines that are highlighted in the following code






	1
2
3
4
5
6
7
8

	        // This method gets called by the runtime. Use this method to add services to the container.
        public void ConfigureServices(IServiceCollection services)
        {
            var connection = @"Server=(localdb)\mssqllocaldb;Database=Blogging;Trusted_Connection=True;";

            services.AddEntityFramework()
                .AddSqlServer()
                .AddDbContext<BloggingContext>(options => options.UseSqlServer(connection));












Create a controller

Next, we’ll add an MVC controller that will use EF to query and save data.



	Right-click on the Controllers folder in Solution Explorer and select Add ‣ New Item...

	From the left menu select Installed ‣ Server-side

	Select the Class item template

	Enter BlogsController.cs as the name and click OK

	Replace the contents of the file with the following code






	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34
35
36
37
38
39
40
41

	using EFGetStarted.AspNet5.ExistingDb.Models;
using Microsoft.AspNet.Mvc;
using System.Linq;

namespace EFGetStarted.AspNet5.ExistingDb.Controllers
{
    public class BlogsController : Controller
    {
        private BloggingContext _context;

        public BlogsController(BloggingContext context)
        {
            _context = context;
        }

        public IActionResult Index()
        {
            return View(_context.Blog.ToList());
        }

        public IActionResult Create()
        {
            return View();
        }

        [HttpPost]
        [ValidateAntiForgeryToken]
        public IActionResult Create(Blog blog)
        {
            if (ModelState.IsValid)
            {
                _context.Blog.Add(blog);
                _context.SaveChanges();
                return RedirectToAction("Index");
            }

            return View(blog);
        }

    }
}







You’ll notice that the controller takes a BloggingContext as a constructor parameter. ASP.NET dependency injection will take care of passing an instance of BloggingContext into your controller.

The controller contains an Index action, which displays all blogs in the database, and a Create action, which inserts a new blogs into the database.




Create views

Now that we have a controller it’s time to add the views that will make up the user interface.

We’ll start with the view for our Index action, that displays all blogs.



	Right-click on the Views folder in Solution Explorer and select Add ‣ New Folder

	Enter Blogs as the name of the folder

	Right-click on the Blogs folder and select Add ‣ New Item...

	From the left menu select Installed ‣ Server-side

	Select the MVC View Page item template

	Enter Index.cshtml as the name and click OK

	Replace the contents of the file with the following code






	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30

	@model IEnumerable<EFGetStarted.AspNet5.ExistingDb.Models.Blog>

@{
    ViewBag.Title = "Blogs";
}

<h2>Blogs</h2>

<p>
    <a asp-controller="Blogs" asp-action="Create">Create New</a>
</p>

<table class="table">
    <tr>
        <th>Id</th>
        <th>Url</th>
    </tr>

    @foreach (var item in Model)
    {
        <tr>
            <td>
                @Html.DisplayFor(modelItem => item.BlogId)
            </td>
            <td>
                @Html.DisplayFor(modelItem => item.Url)
            </td>
        </tr>
    }
</table>







We’ll also add a view for the Create action, which allows the user to enter details for a new blog.



	Right-click on the Blogs folder and select Add ‣ New Item...

	From the left menu select Installed ‣ ASP.NET 5

	Select the MVC View Page item template

	Enter Create.cshtml as the name and click OK

	Replace the contents of the file with the following code






	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25

	@model EFGetStarted.AspNet5.ExistingDb.Models.Blog

@{
    ViewBag.Title = "New Blog";
}

<h2>@ViewData["Title"]</h2>

<form asp-controller="Blogs" asp-action="Create" method="post" class="form-horizontal" role="form">
    <div class="form-horizontal">
        <div asp-validation-summary="ValidationSummary.All" class="text-danger"></div>
        <div class="form-group">
            <label asp-for="Url" class="col-md-2 control-label"></label>
            <div class="col-md-10">
                <input asp-for="Url" class="form-control" />
                <span asp-validation-for="Url" class="text-danger"></span>
            </div>
        </div>
        <div class="form-group">
            <div class="col-md-offset-2 col-md-10">
                <input type="submit" value="Create" class="btn btn-default" />
            </div>
        </div>
    </div>
</form>










Run the application

You can now run the application to see it in action.



	Debug ‣ Start Without Debugging

	The application will build and open in a web browser

	Navigate to /Blogs

	Click Create New

	Enter a Url for the new blog and click Create
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警告

This documentation is for EF7 onwards. For EF6.x and earlier release see http://msdn.com/data/ef.
本文档是基于EF7版本.对于EF6.x及更早的版本请参见 http://msdn.com/data/ef.




注解

This article uses EF 7.0.0-rc1 which is the latest pre-release available on NuGet.org. You can find nightly builds of the EF7 code base hosted on https://www.myget.org/F/aspnetvnext/ but we do not maintain up-to-date documentation for nightly builds.




Getting Started on Universal Windows Platform

In this walkthrough, you will build a Universal Windows Platform (UWP) application that performs basic data access against a local SQLite database using Entity Framework.


警告

Deploying a UWP application to the app store requires your application to be compiled with .NET Native. When using Entity Framework there are some query APIs you should avoid to ensure your application is compatible with .NET Native.


	You can query using simple LINQ operators that do not change the type of results returned by the query

	
	Where

	OrderBy

	Distinct

	Skip/Take

	ToList/ToArray

	etc.





	You cannot use operators that would change the type of results returned by the query. We are working to support these operators and you can track our progress on GitHub [https://github.com/aspnet/EntityFramework/issues/3603].

	
	Select (you can select a single property, but not an anonymous type)

	GroupBy

	Include/ThenInclude

	Join

	etc.










	In this article:

	
	Prerequisites

	Create a new project

	Install Entity Framework

	Create your model

	Create your database

	Use your model








小技巧

You can view this article’s sample [https://github.com/aspnet/EntityFramework.Docs/tree/master/docs/getting-started/uwp/sample] on GitHub.




Prerequisites


	The following items are required to complete this walkthrough:

	
	Windows 10

	Visual Studio 2015

	The latest version of Windows 10 Developer Tools [https://dev.windows.com/en-us/downloads]










Create a new project


	Open Visual Studio 2015

	File ‣ New ‣ Project...

	From the left menu select Templates ‣ Visual C# ‣ Windows ‣ Universal

	Select the Blank App (Universal Windows) project template

	Give the project a name and click OK




警告

To work around an issue with EF7 and .NET Native [https://github.com/aspnet/EntityFramework/issues/3768], you need to add a runtime directive to your application. This issue will be fixed for future releases.


	Open Properties/Default.rd.xml

	Add the highlighted line shown below



    <!-- Add your application specific runtime directives here. -->
    <Type Name="System.Collections.ArrayList" Dynamic="Required All" />










Install Entity Framework

To use EF7 you install the package for the database provider(s) you want to target. This walkthrough uses SQLite. For a list of available providers see Database Providers.


	Tools ‣ NuGet Package Manager ‣ Package Manager Console

	Run Install-Package EntityFramework.SQLite –Pre



Later in this walkthrough we will also be using some Entity Framework commands to maintain the database. So we will install the commands package as well.


	Run Install-Package EntityFramework.Commands –Pre






Create your model

Now it’s time to define a context and entity classes that make up your model.


	Project ‣ Add Class...

	Enter Model.cs as the name and click OK

	Replace the contents of the file with the following code




警告

The try/catch code to set databaseFilePath is a temporary workaround to enable migrations to be added at design time. When the application runs, databaseFilePath will always be under ApplicationData.Current.LocalFolder.Path. However, that API can not be called when migrations creates the context at design time in Visual Studio. The database is never accessed when adding migrations, so we just return a relative file path that will never be used.




注解

Notice the OnConfiguring method (new in EF7) that is used to specify the provider to use and, optionally, other configuration too.



	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34
35
36
37
38
39
40
41
42

	using Microsoft.Data.Entity;
using System.Collections.Generic;

namespace EFGetStarted.UWP
{
    public class BloggingContext : DbContext
    {
        public DbSet<Blog> Blogs { get; set; }
        public DbSet<Post> Posts { get; set; }

        protected override void OnConfiguring(DbContextOptionsBuilder optionsBuilder)
        {
            optionsBuilder.UseSqlite($"Filename=Blogging.db");
        }

        protected override void OnModelCreating(ModelBuilder modelBuilder)
        {
            // Make Blog.Url required
            modelBuilder.Entity<Blog>()
                .Property(b => b.Url)
                .IsRequired();
        }
    }

    public class Blog
    {
        public int BlogId { get; set; }
        public string Url { get; set; }

        public List<Post> Posts { get; set; }
    }

    public class Post
    {
        public int PostId { get; set; }
        public string Title { get; set; }
        public string Content { get; set; }

        public int BlogId { get; set; }
        public Blog Blog { get; set; }
    }
}








小技巧

In a real application you would typically put each class from your model in a separate file. For the sake of simplicity, we are putting all the classes in one file for this tutorial.






Create your database

Now that you have a model, you can use migrations to create a database for you.


	Build -> Build Solution

	Tools –> NuGet Package Manager –> Package Manager Console

	Run Add-Migration MyFirstMigration to scaffold a migration to create the initial set of tables for your model.




警告

Notice that you need to manually build the solution before running the Add-Migration command. The command does invoke the build operation on the project, but we are currently investigating why this does not result in the correct assemblies being outputted.



Since we want the database to be created on the device that the app runs on, we will add some code to apply any pending migrations to the local database on application startup. The first time that the app runs, this will take care of creating the local database for us.


	Right-click on App.xaml in Solution Explorer and select View Code

	Add the highlighted using to the start of the file



	1
2
3
4
5
6

	using System;
using Microsoft.Data.Entity;
using System.Collections.Generic;
using System.IO;
using System.Linq;
using System.Runtime.InteropServices.WindowsRuntime;








	Add the highlighted code to apply any pending migrations



	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13

	        public App()
        {
            Microsoft.ApplicationInsights.WindowsAppInitializer.InitializeAsync(
                Microsoft.ApplicationInsights.WindowsCollectors.Metadata |
                Microsoft.ApplicationInsights.WindowsCollectors.Session);
            this.InitializeComponent();
            this.Suspending += OnSuspending;

            using (var db = new BloggingContext())
            {
                db.Database.Migrate();
            }
        }








小技巧

If you make future changes to your model, you can use the Add-Migration command to scaffold a new migration to apply the corresponding changes to the database. Any pending migrations will be applied to the local database on each device when the application starts.

EF uses a __EFMigrationsHistory table in the database to keep track of which migrations have already been applied to the database.






Use your model

You can now use your model to perform data access.


	Open MainPage.xaml

	Add the page load handler and UI content highlighted below



	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24

	<Page
    x:Class="EFGetStarted.UWP.MainPage"
    xmlns="http://schemas.microsoft.com/winfx/2006/xaml/presentation"
    xmlns:x="http://schemas.microsoft.com/winfx/2006/xaml"
    xmlns:local="using:EFGetStarted.UWP"
    xmlns:d="http://schemas.microsoft.com/expression/blend/2008"
    xmlns:mc="http://schemas.openxmlformats.org/markup-compatibility/2006"
    mc:Ignorable="d"
    Loaded="Page_Loaded">

    <Grid Background="{ThemeResource ApplicationPageBackgroundThemeBrush}">
        <StackPanel>
            <TextBox Name="NewBlogUrl"></TextBox>
            <Button Click="Add_Click">Add</Button>
            <ListView Name="Blogs">
                <ListView.ItemTemplate>
                    <DataTemplate>
                        <TextBlock Text="{Binding Url}" />
                    </DataTemplate>
                </ListView.ItemTemplate>
            </ListView>
        </StackPanel>
    </Grid>
</Page>







Now we’ll add code to wire up the UI with the database


	Right-click MainPage.xaml in Solution Explorer and select View Code

	Add the highlighted code from the following listing



	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27

	    public sealed partial class MainPage : Page
    {
        public MainPage()
        {
            this.InitializeComponent();
        }

        private void Page_Loaded(object sender, RoutedEventArgs e)
        {
            using (var db = new BloggingContext())
            {
                Blogs.ItemsSource = db.Blogs.ToList();
            }
        }

        private void Add_Click(object sender, RoutedEventArgs e)
        {
            using (var db = new BloggingContext())
            {
                var blog = new Blog { Url = NewBlogUrl.Text };
                db.Blogs.Add(blog);
                db.SaveChanges();

                Blogs.ItemsSource = db.Blogs.ToList();
            }
        }
    }







You can now run the application to see it in action.


	Debug ‣ Start Without Debugging

	The application will build and launch

	Enter a URL and click the Add button
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警告

This documentation is for EF7 onwards. For EF6.x and earlier release see http://msdn.com/data/ef.
本文档是基于EF7版本.对于EF6.x及更早的版本请参见 http://msdn.com/data/ef.




注解

This article uses EF 7.0.0-rc1 which is the latest pre-release available on NuGet.org. You can find nightly builds of the EF7 code base hosted on https://www.myget.org/F/aspnetvnext/ but we do not maintain up-to-date documentation for nightly builds.




Getting Started on OSX

This walkthrough will create a simple console application using ASP.NET 5 and
the SQLite provider.


In this article:


	Prerequisites

	Install ASP.NET 5

	Create a new project

	Create your model

	Create your database

	Use your model

	Start your app






小技巧

You can view this article’s sample [https://github.com/aspnet/EntityFramework.Docs/tree/master/docs/getting-started/x-plat/sample] on GitHub.




Prerequisites


	Minimum system requirements

	
	OS X Yosemite or newer








警告

Known Issues


	DNX-coreclr will die silentily if you are missing the ICU library. Make sure to install all dependencies listed in the install guide. (See Issue dnx#2875 [https://github.com/aspnet/dnx/issues/2875])

	Migrations on SQLite do not support more complex schema changes due to limitations in SQLite itself.

	Package names are case-sensitive on Linux and OS X due to the case-sensitive filesystem. Make sure to use EntityFramework.Sqlite not EntityFramework.SQLite in your project.json file. (See Issue dotnet/cli#236 [https://github.com/dotnet/cli/issues/236])








Install ASP.NET 5

A summary of steps to install ASP.NET 5 are included below. For a more up-to-date guide, follow the steps for Installing ASP.NET 5 on Mac OS X [http://docs.asp.net/en/latest/getting-started/installing-on-mac.html]. This will ensure you meet the following requirements.

The following steps will install dnvm [https://github.com/aspnet/home#running-an-application], a command-line tool for installing the .NET Execution environment.



	Install Homebrew [http://brew.sh]



	Use brew to install ICU


~ $ brew install icu4c










	Run the dnvm


~ $ curl -sSL https://raw.githubusercontent.com/aspnet/Home/dev/dnvminstall.sh | DNX_BRANCH=dev sh && source ~/.dnx/dnvm/dnvm.sh










	Install the latest version of DNX. The -r selects the CoreCLR runtime. OSX also supports the Mono runtime, but it is not used in this tutorial.


~ $ dnvm upgrade -r coreclr















If you have trouble installing dnvm, consult Installing ASP.NET 5 on Mac OS X [http://docs.asp.net/en/latest/getting-started/installing-on-mac.html].




Create a new project



	Create a new folder ConsoleApp/ for your project. All files for the project should be contained in this folder.


~ $ mkdir ConsoleApp
~ $ cd ConsoleApp/










	Create a new file project.json with the following contents


	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17
18

	{
    "dependencies": {
        "EntityFramework.Sqlite": "7.0.0-rc1-final",
        "EntityFramework.Commands": "7.0.0-rc1-final",
        "Microsoft.Extensions.PlatformAbstractions": "1.0.0-rc1-final"
    },
    "commands": {
        "run": "ConsoleApp",
        "ef": "EntityFramework.Commands"
    },
    "frameworks": {
        "dnxcore50": {
            "dependencies": {
                "System.Console": "4.0.0-beta-*"
            }
        }
    }
}












	Execute the following command to install the packages required for this project, including EntityFramework 7 and all its dependencies.


~/ConsoleApp/ $ dnu restore










	Create a new file named Program.cs. Add the following contents to


	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12

	using System;

namespace ConsoleApp
{
    public class Program
    {
        public static void Main()
        {
            Console.WriteLine("Hello EF!");
        }
    }
}

















To verify that this project has all dependencies and packages installed, perform the following steps:



	Verify execution of the program works by running dnx run.


~/ConsoleApp/ $ dnx run
Hello EF!










	Verify that Entity Framework is installed by running dnx ef.


~/ConsoleApp/ $ dnx ef

                     _/\__
               ---==/    \\
         ___  ___   |.    \|\
        | __|| __|  |  )   \\\
        | _| | _|   \_/ |  //|\\
        |___||_|       /   \\\/\\

Entity Framework Commands 7.0.0-rc1-16297

Usage: dnx ef [options] [command]

Options:
  --version     Show version information
  -?|-h|--help  Show help information

Commands:
  database    Commands to manage your database
  dbcontext   Commands to manage your DbContext types
  migrations  Commands to manage your migrations

Use "dnx ef [command] --help" for more information about a command.


















Create your model

With this new project, you are ready to begin using Entity Framework.
We will create a simple console application that allows us to write a
blog post from the command line.



	
	Create a new file called Model.cs

	All classes in the following steps will be added to this file.


	1
2
3
4
5
6
7

	using System.Collections.Generic;
using System.IO;
using Microsoft.Data.Entity;
using Microsoft.Extensions.PlatformAbstractions;

namespace ConsoleApp
{
















	
	Add a new class to represent the SQLite database.

	We will call this BloggingContext. The call to UseSqlite() configures EF to point to a *.db file in the same folder as the project.json file for our project.


	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11

	    public class BloggingContext : DbContext
    {
        public DbSet<Blog> Blogs { get; set; }
        public DbSet<Post> Posts { get; set; }

        protected override void OnConfiguring(DbContextOptionsBuilder optionsBuilder)
        {
            var path = PlatformServices.Default.Application.ApplicationBasePath;
            optionsBuilder.UseSqlite("Filename=" + Path.Combine(path, "blog.db"));
        }
    }
















	
	Add classes to represent tables.

	Note that we will be using foreign keys to associate many posts to one blog.


	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17
18

	    public class Blog
    {
        public int BlogId { get; set; }
        public string Url { get; set; }
        public string Name { get; set; }

        public List<Post> Posts { get; set; }
    }

    public class Post
    {
        public int PostId { get; set; }
        public string Title { get; set; }
        public string Content { get; set; }

        public int BlogId { get; set; }
        public Blog Blog { get; set; }
    }
















	To make sure the files are correct, you can compile the project on the command line by running dnu build --quiet


~/ConsoleApp/ $ dnu build --quiet
Microsoft .NET Development Utility CoreClr-x64-1.0.0-rc1-16137

Building ConsoleApp for DNXCore,Version=v5.0

Build succeeded.
    0 Warning(s)
    0 Error(s)

Time elapsed 00:00:03.7102187
Total build time elapsed: 00:00:03.8096587
Total projects built: 1


















Create your database

We can now use Entity Framework commands to create and manage the schema of our database.



	
	Create the first migration.

	Execute the command below to generate your first migration.
This will find our context and models, and generate a migration for us in a folder named Migrations/

~/ConsoleApp/ $ dnx ef migrations add MyFirstMigration











	
	Apply the migrations.

	You can now begin using the existing migration to create the database file and creates the tables.

~/ConsoleApp/ $ dnx ef database update





This should create a new file, blog.db which contains two empty tables.















Use your model

Now that we have configured our model and created the database schema, we can use BloggingContext to create, update, and delete objects.

	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24

	using System;

namespace ConsoleApp
{
    public class Program
    {
        public static void Main()
        {
            using (var db = new BloggingContext())
            {
                db.Blogs.Add(new Blog { Url = "http://blogs.msdn.com/adonet" });
                var count = db.SaveChanges();
                Console.WriteLine("{0} records saved to database", count);

                Console.WriteLine();
                Console.WriteLine("All blogs in database:");
                foreach (var blog in db.Blogs)
                {
                    Console.WriteLine(" - {0}", blog.Url);
                }
            }
        }
    }
}










Start your app

Run the application from the command line.


~/ConsoleApp/ $ dnx run
1 records saved to database

All blogs in database:
  - http://blogs.msdn.com/adonet








After adding the new post, you can verify the data has been added by inspecting the SQLite database file, blog.db.







          

      

      

    

  

    
      
          
            
  
警告

This documentation is for EF7 onwards. For EF6.x and earlier release see http://msdn.com/data/ef.
本文档是基于EF7版本.对于EF6.x及更早的版本请参见 http://msdn.com/data/ef.




注解

This article uses EF 7.0.0-rc1 which is the latest pre-release available on NuGet.org. You can find nightly builds of the EF7 code base hosted on https://www.myget.org/F/aspnetvnext/ but we do not maintain up-to-date documentation for nightly builds.




Getting Started on Linux

This walkthrough will create a simple console application using ASP.NET 5 and
the SQLite provider.


In this article:


	Prerequisites

	Install ASP.NET 5

	Install SQLite

	Create a new project

	Create your model

	Create your database

	Use your model

	Start your app






小技巧

You can view this article’s sample [https://github.com/aspnet/EntityFramework.Docs/tree/master/docs/getting-started/x-plat/sample] on GitHub.




Prerequisites


	Minimum system requirements

	
	Ubuntu, Debian or one of their derivatives








警告

Known Issues


	DNX-coreclr will die silentily if you are missing the ICU library. Make sure to install all dependencies listed in the install guide. (See Issue dnx#2875 [https://github.com/aspnet/dnx/issues/2875])

	Migrations on SQLite do not support more complex schema changes due to limitations in SQLite itself.

	Package names are case-sensitive on Linux and OS X due to the case-sensitive filesystem. Make sure to use EntityFramework.Sqlite not EntityFramework.SQLite in your project.json file. (See Issue dotnet/cli#236 [https://github.com/dotnet/cli/issues/236])








Install ASP.NET 5

A summary of steps to install ASP.NET 5 are included below. For a more up-to-date guide, follow the steps for Installing ASP.NET 5 on Linux [http://docs.asp.net/en/latest/getting-started/installing-on-linux.html]. This will ensure you meet the following requirements.

The following steps will install dnvm [https://github.com/aspnet/home#running-an-application], a command-line tool for installing the .NET Execution environment.



	Install the required libraries


~ $ sudo apt-get install unzip curl libunwind8 gettext libssl-dev libcurl3-dev zlib1g libicu-dev










	Install dnvm


~ $ curl -sSL https://raw.githubusercontent.com/aspnet/Home/dev/dnvminstall.sh | DNX_BRANCH=dev sh && source ~/.dnx/dnvm/dnvm.sh














	Install the latest version of DNX. The -r selects the CoreCLR runtime. Linux also supports the Mono runtime, but it is not used in this tutorial.

~ $ dnvm upgrade -r coreclr















If you have trouble installing dnvm, consult Installing ASP.NET 5 on Linux [http://docs.asp.net/en/latest/getting-started/installing-on-linux.html].




Install SQLite

EntityFramework.SQLite requires libsqlite3. This may not be installed by default.

On Ubuntu 14, install the SQLite library.


~ $ sudo apt-get install libsqlite3-dev











Create a new project



	Create a new folder ConsoleApp/ for your project. All files for the project should be contained in this folder.


~ $ mkdir ConsoleApp
~ $ cd ConsoleApp/










	Create a new file project.json with the following contents


	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17
18

	{
    "dependencies": {
        "EntityFramework.Sqlite": "7.0.0-rc1-final",
        "EntityFramework.Commands": "7.0.0-rc1-final",
        "Microsoft.Extensions.PlatformAbstractions": "1.0.0-rc1-final"
    },
    "commands": {
        "run": "ConsoleApp",
        "ef": "EntityFramework.Commands"
    },
    "frameworks": {
        "dnxcore50": {
            "dependencies": {
                "System.Console": "4.0.0-beta-*"
            }
        }
    }
}












	Execute the following command to install the packages required for this project, including EntityFramework 7 and all its dependencies.


~/ConsoleApp/ $ dnu restore










	Create a new file named Program.cs. Add the following contents to


	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12

	using System;

namespace ConsoleApp
{
    public class Program
    {
        public static void Main()
        {
            Console.WriteLine("Hello EF!");
        }
    }
}

















To verify that this project has all dependencies and packages installed, perform the following steps:



	Verify execution of the program works by running dnx run.


~/ConsoleApp/ $ dnx run
Hello EF!










	Verify that Entity Framework is installed by running dnx ef.


~/ConsoleApp/ $ dnx ef

                     _/\__
               ---==/    \\
         ___  ___   |.    \|\
        | __|| __|  |  )   \\\
        | _| | _|   \_/ |  //|\\
        |___||_|       /   \\\/\\

Entity Framework Commands 7.0.0-rc1-16297

Usage: dnx ef [options] [command]

Options:
  --version     Show version information
  -?|-h|--help  Show help information

Commands:
  database    Commands to manage your database
  dbcontext   Commands to manage your DbContext types
  migrations  Commands to manage your migrations

Use "dnx ef [command] --help" for more information about a command.


















Create your model

With this new project, you are ready to begin using Entity Framework.
We will create a simple console application that allows us to write a
blog post from the command line.



	
	Create a new file called Model.cs

	All classes in the following steps will be added to this file.


	1
2
3
4
5
6
7

	using System.Collections.Generic;
using System.IO;
using Microsoft.Data.Entity;
using Microsoft.Extensions.PlatformAbstractions;

namespace ConsoleApp
{
















	
	Add a new class to represent the SQLite database.

	We will call this BloggingContext. The call to UseSqlite() configures EF to point to a *.db file in the same folder as the project.json file for our project.


	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11

	    public class BloggingContext : DbContext
    {
        public DbSet<Blog> Blogs { get; set; }
        public DbSet<Post> Posts { get; set; }

        protected override void OnConfiguring(DbContextOptionsBuilder optionsBuilder)
        {
            var path = PlatformServices.Default.Application.ApplicationBasePath;
            optionsBuilder.UseSqlite("Filename=" + Path.Combine(path, "blog.db"));
        }
    }
















	
	Add classes to represent tables.

	Note that we will be using foreign keys to associate many posts to one blog.


	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17
18

	    public class Blog
    {
        public int BlogId { get; set; }
        public string Url { get; set; }
        public string Name { get; set; }

        public List<Post> Posts { get; set; }
    }

    public class Post
    {
        public int PostId { get; set; }
        public string Title { get; set; }
        public string Content { get; set; }

        public int BlogId { get; set; }
        public Blog Blog { get; set; }
    }
















	To make sure the files are correct, you can compile the project on the command line by running dnu build --quiet


~/ConsoleApp/ $ dnu build --quiet
Microsoft .NET Development Utility CoreClr-x64-1.0.0-rc1-16137

Building ConsoleApp for DNXCore,Version=v5.0

Build succeeded.
    0 Warning(s)
    0 Error(s)

Time elapsed 00:00:03.7102187
Total build time elapsed: 00:00:03.8096587
Total projects built: 1


















Create your database

We can now use Entity Framework commands to create and manage the schema of our database.



	
	Create the first migration.

	Execute the command below to generate your first migration.
This will find our context and models, and generate a migration for us in a folder named Migrations/

~/ConsoleApp/ $ dnx ef migrations add MyFirstMigration











	
	Apply the migrations.

	You can now begin using the existing migration to create the database file and creates the tables.

~/ConsoleApp/ $ dnx ef database update





This should create a new file, blog.db which contains two empty tables.















Use your model

Now that we have configured our model and created the database schema, we can use BloggingContext to create, update, and delete objects.

	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24

	using System;

namespace ConsoleApp
{
    public class Program
    {
        public static void Main()
        {
            using (var db = new BloggingContext())
            {
                db.Blogs.Add(new Blog { Url = "http://blogs.msdn.com/adonet" });
                var count = db.SaveChanges();
                Console.WriteLine("{0} records saved to database", count);

                Console.WriteLine();
                Console.WriteLine("All blogs in database:");
                foreach (var blog in db.Blogs)
                {
                    Console.WriteLine(" - {0}", blog.Url);
                }
            }
        }
    }
}










Start your app

Run the application from the command line.


~/ConsoleApp/ $ dnx run
1 records saved to database

All blogs in database:
  - http://blogs.msdn.com/adonet








After adding the new post, you can verify the data has been added by inspecting the SQLite database file, blog.db.







          

      

      

    

  

    
      
          
            
  
警告

This documentation is for EF7 onwards. For EF6.x and earlier release see http://msdn.com/data/ef.
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Database Providers


	The following providers are either available or being developed:

	
	EntityFramework.MicrosoftSqlServer

	EntityFramework.SQLite

	EntityFramework.InMemory

	EntityFramework.SqlServerCompact40

	EntityFramework.SqlServerCompact35

	EntityFramework.Npgsql








EntityFramework.MicrosoftSqlServer

Database Engine: Microsoft SQL Server (2008 onwards)

Platforms: Full .NET (4.5.1 onwards), DNX/ASP.NET 5 (dnx451 and dnxcore50), Mono (4.2.0 onwards)


警告

Using this provider on Mono will make use of the Mono SQL Client implementation, which has a number of known issues. For example, it does not support secure connections (SSL).



Status: Pre-release EntityFramework.MicrosoftSqlServer package on NuGet.org [https://www.nuget.org/packages/EntityFramework.MicrosoftSqlServer] that supports the latest EF7 pre-release

Project Site: EntityFramework GitHub project [https://github.com/aspnet/EntityFramework]

Getting Started: See Getting Started on Full .NET (Console, WinForms, WPF, etc.) or Getting Started on ASP.NET 5 for a walkthrough that uses this provider. The UnicornStore [https://github.com/rowanmiller/UnicornStore/tree/master/UnicornStore] sample application also uses this provider.




EntityFramework.SQLite

Database Engine: SQLite (3.7 onwards)

Platforms: Full .NET (4.5.1 onwards), DNX/ASP.NET 5 (dnx451 and dnxcore50), Mono (4.2.0 onwards), Universal Windows Platform (local development only)

Status: Pre-release EntityFramework.SQLite package on NuGet.org [https://www.nuget.org/packages/EntityFramework.SQLite] that supports the latest EF7 pre-release

Project Site: EntityFramework GitHub project [https://github.com/aspnet/EntityFramework]

Getting Started: See Getting Started on Universal Windows Platform, Getting Started on Linux or Getting Started on OSX for walkthroughs that use this provider




EntityFramework.InMemory

Database Engine: Built-in in-memory database (designed for testing purposes only)

Platforms: Full .NET (4.5.1 onwards), DNX/ASP.NET 5 (dnx451 and dnxcore50), Mono (4.2.0 onwards), Universal Windows Platform (local development only)

Status: Pre-release EntityFramework.InMemory package on NuGet.org [https://www.nuget.org/packages/EntityFramework.InMemory] that supports the latest EF7 pre-release

Project Site: EntityFramework GitHub project [https://github.com/aspnet/EntityFramework]

Getting Started: See the tests for the UnicornStore sample application [https://github.com/rowanmiller/UnicornStore/blob/master/UnicornStore/src/UnicornStore.Tests/Controllers/ShippingControllerTests.cs] for an example of using this provider.




EntityFramework.SqlServerCompact40

Database Engine: SQL Server Compact Edition 4.0

Platforms: Full .NET (4.5.1 onwards), DNX/ASP.NET 5 (dnx451 only)

Status: Pre-release EntityFramework.SqlServerCompact40 package on NuGet.org [https://www.nuget.org/packages/EntityFramework.SqlServerCompact40] that supports the latest EF7 pre-release

Project Site: ErikEJ/EntityFramework7.SqlServerCompact GitHub Project [https://github.com/ErikEJ/EntityFramework7.SqlServerCompact]

Getting Started: See the documentation for this project [https://github.com/ErikEJ/EntityFramework7.SqlServerCompact/wiki/Using-EF7-with-SQL-Server-Compact-in-Traditional-.NET-Applications]




EntityFramework.SqlServerCompact35

Database Engine: SQL Server Compact Edition 3.5

Platforms: Full .NET (4.5.1 onwards), DNX/ASP.NET 5 (dnx451 only)

Status: Pre-release EntityFramework.SqlServerCompact35 package on NuGet.org [https://www.nuget.org/packages/EntityFramework.SqlServerCompact35] that supports the latest EF7 pre-release

Project Site: ErikEJ/EntityFramework7.SqlServerCompact GitHub Project [https://github.com/ErikEJ/EntityFramework7.SqlServerCompact]

Getting Started: See the documentation for this project [https://github.com/ErikEJ/EntityFramework7.SqlServerCompact/wiki/Using-EF7-with-SQL-Server-Compact-in-Traditional-.NET-Applications]




EntityFramework.Npgsql

Database Engine: PostgreSQL

Platforms: Full .NET (4.5.1 onwards), DNX/ASP.NET 5 (dnx451 and dnxcore50), Mono (4.2.0 onwards)

Status: Pre-release EntityFramework7.Npgsql package on NuGet.org [https://www.nuget.org/packages/EntityFramework7.Npgsql/] that supports the latest EF7 pre-release

Project Site: Npgsql.org [http://www.npgsql.org]

Getting Started: See the getting started documentation at the Npgsql site [http://www.npgsql.org/doc/ef7.html]
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Modeling

Entity Framework uses a set of conventions to build a model based on the shape of your entity classes. You can specify additional configuration to supplement and/or override what was discovered by convention.

This article covers configuration that can be applied to a model targeting any data store and that which can be applied when targeting any relational database. Providers may also enable configuration that is specific to a particular data store. For documentation on provider specific configuration see the the Database Providers section.

In this section you can find information about conventions and configuration for the following:



	Including & Excluding Types

	Including & Excluding Properties

	Keys (primary)

	Generated Properties

	Required/optional properties

	Maximum Length

	Concurrency Tokens

	Shadow Properties

	Relationships

	Indexes

	Alternate Keys

	Inheritance

	Relational Database Modeling
	Table Mapping

	Column Mapping

	Data Types

	Primary Keys

	Default Schema

	Computed Columns

	Sequences

	Default Values

	Indexes

	Foreign Key Constraints

	Alternate Keys (Unique Constraints)

	Inheritance (Relational Database)










小技巧

You can view this article’s sample [https://github.com/aspnet/EntityFramework.Docs/tree/master/docs/modeling/configuring/sample] on GitHub.




Methods of configuration


Fluent API

You can override the OnModelCreating method in your derived context and use the ModelBuilder API to configure your model. This is the most powerful method of configuration and allows configuration to be specified without modifying your entity classes. Fluent API configuration has the highest precedence and will override conventions and data annotations.

	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11

	    class MyContext : DbContext
    {
        public DbSet<Blog> Blogs { get; set; }

        protected override void OnModelCreating(ModelBuilder modelBuilder)
        {
            modelBuilder.Entity<Blog>()
                .Property(b => b.Url)
                .IsRequired();
        }
    }










Data Annotations

You can also apply attributes (known as Data Annotations) to your classes and properties. Data annotations will override conventions, but will be overwritten by Fluent API configuration.

	1
2
3
4
5
6

	    public class Blog
    {
        public int BlogId { get; set; }
        [Required]
        public string Url { get; set; }
    }
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注解

This article uses EF 7.0.0-rc1 which is the latest pre-release available on NuGet.org. You can find nightly builds of the EF7 code base hosted on https://www.myget.org/F/aspnetvnext/ but we do not maintain up-to-date documentation for nightly builds.




Including & Excluding Types

Including a type in the model means that EF has metadata about that type and will attempt to read and write instances from/to the database.


In this article:


	Including & Excluding Types
	Conventions

	Data Annotations

	Fluent API










Conventions

By convention, types that are exposed in DbSet properties on your context are included in your model. In addition, types that are mentioned in the OnModelCreating method are also included. Finally, any types that are found by recursively exploring the navigation properties of discovered types are also included in the model.


	For example, in the following code listing all three types are discovered:

	
	Blog because it is exposed in a DbSet property on the context

	Post because it is discovered via the Blog.Posts navigation property

	AuditEntry because it is mentioned in OnModelCreating







	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34
35

	    class MyContext : DbContext
    {
        public DbSet<Blog> Blogs { get; set; }

        protected override void OnModelCreating(ModelBuilder modelBuilder)
        {
            modelBuilder.Entity<AuditEntry>()
                .Property(a => a.Username)
                .IsRequired();
        }
    }

    public class Blog
    {
        public int BlogId { get; set; }
        public string Url { get; set; }

        public List<Post> Posts { get; set; }
    }

    public class Post
    {
        public int PostId { get; set; }
        public string Title { get; set; }
        public string Content { get; set; }

        public Blog Blog { get; set; }
    }

    public class AuditEntry
    {
        public int AuditEntryId { get; set; }
        public string Username { get; set; }
        public string Action { get; set; }
    }










Data Annotations

You can use Data Annotations to exclude a type from the model.

	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13

	    public class Blog
    {
        public int BlogId { get; set; }
        public string Url { get; set; }

        public BlogMetadata Metadata { get; set; }
    }

    [NotMapped]
    public class BlogMetadata
    {
        public DateTime LoadedFromDatabase { get; set; }
    }










Fluent API

You can use the Fluent API to exclude a type from the model.

	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17
18
19
20
21
22

	    class MyContext : DbContext
    {
        public DbSet<Blog> Blogs { get; set; }

        protected override void OnModelCreating(ModelBuilder modelBuilder)
        {
            modelBuilder.Ignore<BlogMetadata>();
        }
    }

    public class Blog
    {
        public int BlogId { get; set; }
        public string Url { get; set; }

        public BlogMetadata Metadata { get; set; }
    }

    public class BlogMetadata
    {
        public DateTime LoadedFromDatabase { get; set; }
    }
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注解

This article uses EF 7.0.0-rc1 which is the latest pre-release available on NuGet.org. You can find nightly builds of the EF7 code base hosted on https://www.myget.org/F/aspnetvnext/ but we do not maintain up-to-date documentation for nightly builds.




Including & Excluding Properties

Including a property in the model means that EF has metadata about that property and will attempt to read and write values from/to the database.


In this article:


	Including & Excluding Properties
	Conventions

	Data Annotations

	Fluent API










Conventions

By convention, every property on each entity type will be included in the model. This includes private properties and those without a getter or setter.




Data Annotations

You can use Data Annotations to exclude a property from the model.

	1
2
3
4
5
6
7
8

	    public class Blog
    {
        public int BlogId { get; set; }
        public string Url { get; set; }

        [NotMapped]
        public DateTime LoadedFromDatabase { get; set; }
    }










Fluent API

You can use the Fluent API to exclude a property from the model.

	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17
18

	    class MyContext : DbContext
    {
        public DbSet<Blog> Blogs { get; set; }

        protected override void OnModelCreating(ModelBuilder modelBuilder)
        {
            modelBuilder.Entity<Blog>()
                .Ignore(b => b.LoadedFromDatabase);
        }
    }

    public class Blog
    {
        public int BlogId { get; set; }
        public string Url { get; set; }

        public DateTime LoadedFromDatabase { get; set; }
    }
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Keys (primary)

A key serves as the primary unique identifier for each entity instance. When using a relational database this maps to the concept of a primary key. You can also configure a unique identifier that is not the primary key (see Alternate Keys for more information).


In this article:


	Keys (primary)
	Conventions

	Data Annotations

	Fluent API










Conventions

By convention, a property named Id or <type name>Id will be configured as the key of an entity.

	1
2
3
4
5
6
7

	    class Car
    {
        public string Id { get; set; }

        public string Make { get; set; }
        public string Model { get; set; }
    }







	1
2
3
4
5
6
7

	    class Car
    {
        public string CarId { get; set; }

        public string Make { get; set; }
        public string Model { get; set; }
    }










Data Annotations

You can use Data Annotations to configure a single property to be the key of an entity.

	1
2
3
4
5
6
7
8

	    class Car
    {
        [Key]
        public string LicensePlate { get; set; }

        public string Make { get; set; }
        public string Model { get; set; }
    }










Fluent API

You can use the Fluent API to configure a single property to be the key of an entity.

	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17
18

	    class MyContext : DbContext
    {
        public DbSet<Car> Cars { get; set; }

        protected override void OnModelCreating(ModelBuilder modelBuilder)
        {
            modelBuilder.Entity<Car>()
                .HasKey(c => c.LicensePlate);
        }
    }

    class Car
    {
        public string LicensePlate { get; set; }

        public string Make { get; set; }
        public string Model { get; set; }
    }







You can also use the Fluent API to configure multiple properties to be the key of an entity (known as a composite key). Composite keys can only be configured using the Fluent API - conventions will never setup a composite key and you can not use Data Annotations to configure one.

	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17
18
19

	    class MyContext : DbContext
    {
        public DbSet<Car> Cars { get; set; }

        protected override void OnModelCreating(ModelBuilder modelBuilder)
        {
            modelBuilder.Entity<Car>()
                .HasKey(c => new { c.State, c.LicensePlate });
        }
    }

    class Car
    {
        public string State { get; set; }
        public string LicensePlate { get; set; }

        public string Make { get; set; }
        public string Model { get; set; }
    }
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Generated Properties


In this article:


	Generated Properties
	Value Generation Patterns
	No value generation

	Value generated on add

	Value generated on add or update





	Conventions

	Data Annotations
	No value generation (Data Annotations)

	Value generated on add (Data Annotations)

	Value generated on add or update (Data Annotations)





	Fluent API
	No value generation (Fluent API)

	Value generated on add (Fluent API)

	Value generated on add or update (Fluent API)














Value Generation Patterns

There are three value generation patterns that can be used for properties.


No value generation

No value generation means that you will always supply a valid value to be saved to the database. This valid value must be assigned to new entities before they are added to the context.




Value generated on add

Value generated on add means that a value is generated for new entities.


警告

How the value is generated for added entities will depend on the database provider being used. Database providers may automatically setup value generation for some property types, but others may require you to manually setup how the value is generated.

For example, when using SQL Server, values will be automatically generated for GUID properties (using the SQL Server sequential GUID algorithm). However, if you specify that a DateTime property is generated on add, then you must setup a way for the values to be generated (such as setting default value SQL of GETDATE(), see Default Values).



If you add an entity to the context that has a value assigned to the primary key property, then EF will attempt to insert that value rather than generating a new one. A property is considered to have a value assigned if it is not assigned the CLR default value (null for string, 0 for int, Guid.Empty for Guid, etc.).

Depending on the database provider being used, values may be generated client side by EF or in the database. If the value is generated by the database, then EF may assign a temporary value when you add the entity to the context. This temporary value will then be replaced by the database generated value during SaveChanges.




Value generated on add or update

Value generated on add or update means that a new value is generated every time the record is saved (insert or update).


警告

How the value is generated for added and updated entities will depend on the database provider being used. Database providers may automatically setup value generation for some property types, while others will require you to manually setup how the value is generated.

For example, when using SQL Server, byte[] properties that are set as generated on add or update and marked as concurrency tokens, will be setup with the rowversion data type - so that values will be generated in the database. However, if you specify that a DateTime property is generated on add or update, then you must setup a way for the values to be generated (such as a database trigger).



Like ‘value generated on add’, if you specify a value for the property on a newly added instance of an entity, that value will be inserted rather than a value being generated. Also, if you explicitly change the value assigned to the property (thus marking it as modified) then that new value will be set in the database rather than a value being generated.






Conventions

By convention, primary keys that are of an integer or GUID data type will be setup to have values generated on add. All other properties will be setup with no value generation.




Data Annotations


No value generation (Data Annotations)

	1
2
3
4
5
6

	    public class Blog
    {
        [DatabaseGenerated(DatabaseGeneratedOption.None)]
        public int BlogId { get; set; }
        public string Url { get; set; }
    }










Value generated on add (Data Annotations)

	1
2
3
4
5
6
7

	    public class Blog
    {
        public int BlogId { get; set; }
        public string Url { get; set; }
        [DatabaseGenerated(DatabaseGeneratedOption.Identity)]
        public DateTime Inserted { get; set; }
    }








警告

This just lets EF know that values are generated for added entities, it does not guarantee that EF will setup the actual mechanism to generate values. See Value generated on add section for more details.






Value generated on add or update (Data Annotations)

	1
2
3
4
5
6
7

	    public class Blog
    {
        public int BlogId { get; set; }
        public string Url { get; set; }
        [DatabaseGenerated(DatabaseGeneratedOption.Computed)]
        public DateTime LastUpdated { get; set; }
    }








警告

This just lets EF know that values are generated for added or updated entities, it does not guarantee that EF will setup the actual mechanism to generate values. See Value generated on add or update section for more details.








Fluent API

You can use the Fluent API to change the value generation pattern for a given property.


No value generation (Fluent API)

	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17

	    class MyContext : DbContext
    {
        public DbSet<Blog> Blogs { get; set; }

        protected override void OnModelCreating(ModelBuilder modelBuilder)
        {
            modelBuilder.Entity<Blog>()
                .Property(b => b.BlogId)
                .ValueGeneratedNever();
        }
    }

    public class Blog
    {
        public int BlogId { get; set; }
        public string Url { get; set; }
    }










Value generated on add (Fluent API)

	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17
18

	    class MyContext : DbContext
    {
        public DbSet<Blog> Blogs { get; set; }

        protected override void OnModelCreating(ModelBuilder modelBuilder)
        {
            modelBuilder.Entity<Blog>()
                .Property(b => b.Inserted)
                .ValueGeneratedOnAdd();
        }
    }

    public class Blog
    {
        public int BlogId { get; set; }
        public string Url { get; set; }
        public DateTime Inserted { get; set; }
    }








警告

This just lets EF know that values are generated for added entities, it does not guarantee that EF will setup the actual mechanism to generate values. See Value generated on add section for more details.






Value generated on add or update (Fluent API)

	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17
18

	    class MyContext : DbContext
    {
        public DbSet<Blog> Blogs { get; set; }

        protected override void OnModelCreating(ModelBuilder modelBuilder)
        {
            modelBuilder.Entity<Blog>()
                .Property(b => b.LastUpdated)
                .ValueGeneratedOnAddOrUpdate();
        }
    }

    public class Blog
    {
        public int BlogId { get; set; }
        public string Url { get; set; }
        public DateTime LastUpdated { get; set; }
    }








警告

This just lets EF know that values are generated for added or updated entities, it does not guarantee that EF will setup the actual mechanism to generate values. See Value generated on add or update section for more details.
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Required/optional properties

A property is considered optional if it is valid for it to contain null. If null is not a valid value to be assigned to a property then it is considered to be a required property.


In this article:


	Required/optional properties
	Conventions

	Data Annotations

	Fluent API










Conventions

By convention, a property whose CLR type can contain null will be configured as optional (string, int?, byte[], etc.). Properties whose CLR type cannot contain null will be configured as required (int, decimal, bool, etc.).


注解

A property whose CLR type cannot contain null cannot be configured as optional. The property will always be considered required by Entity Framework.






Data Annotations

You can use Data Annotations to indicate that a property is required.

	1
2
3
4
5
6

	    public class Blog
    {
        public int BlogId { get; set; }
        [Required]
        public string Url { get; set; }
    }










Fluent API

You can use the Fluent API to indicate that a property is required.

	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17

	    class MyContext : DbContext
    {
        public DbSet<Blog> Blogs { get; set; }

        protected override void OnModelCreating(ModelBuilder modelBuilder)
        {
            modelBuilder.Entity<Blog>()
                .Property(b => b.Url)
                .IsRequired();
        }
    }

    public class Blog
    {
        public int BlogId { get; set; }
        public string Url { get; set; }
    }
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Maximum Length

Configuring a maximum length provides a hint to the data store about the appropriate data type to use for a given property. Maximum length only applies to array data types, such as string and byte[].


注解

Entity Framework does not do any validation of maximum length before passing data to the provider. It is up to the provider or data store to validate if appropriate. For example, when targeting SQL Server, exceeding the maximum length will result in an exception as the data type of the underlying column will not allow excess data to be stored.




In this article:


	Maximum Length
	Conventions

	Data Annotations

	Fluent API










Conventions

By convention, it is left up to the database provider to chose an appropriate data type for properties. For properties that have a length, the database provider will generally chose a data type that allows for the longest length of data. For example, Microsoft SQL Server will use nvarchar(max) for string properties (or nvarchar(450) if the column is used as a key).




Data Annotations

You can use the Data Annotations to configure a maximum length for a property. In this example, targeting SQL Server this would result in the nvarchar(500) data type being used.

	1
2
3
4
5
6

	    public class Blog
    {
        public int BlogId { get; set; }
        [MaxLength(500)]
        public string Url { get; set; }
    }










Fluent API

You can use the Fluent API to configure a maximum length for a property. In this example, targeting SQL Server this would result in the nvarchar(500) data type being used.

	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17

	    class MyContext : DbContext
    {
        public DbSet<Blog> Blogs { get; set; }

        protected override void OnModelCreating(ModelBuilder modelBuilder)
        {
            modelBuilder.Entity<Blog>()
                .Property(b => b.Url)
                .HasMaxLength(500);
        }
    }

    public class Blog
    {
        public int BlogId { get; set; }
        public string Url { get; set; }
    }
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Concurrency Tokens

If a property is configured as a concurrency token then EF will check that no other user has modified that value in the database when saving changes to that record. EF uses an optimistic concurrency pattern, meaning it will assume the value has not changed and try to save the data, but throw if it finds the value has been changed.

For example we may want to configure SocialSecurityNumber on Person to be a concurrency token. This means that if one user tries to save some changes to a Person, but another user has changed the SocialSecurityNumber then an exception will be thrown. This may be desirable so that your application can prompt the user to ensure this record still represents the same actual person before saving their changes.


In this article:


	Concurrency Tokens
	How concurrency tokens work in EF

	Conventions

	Data Annotations

	Fluent API

	Timestamp/row version
	Conventions

	Data Annotations

	Fluent API














How concurrency tokens work in EF

Data stores can enforce concurrency tokens by checking that any record being updated or deleted still has the same value for the concurrency token that was assigned when the context originally loaded the data from the database.

For example, relational database achieve this by including the concurrency token in the WHERE clause of any UPDATE or DELETE commands and checking the number of rows that were affected. If the concurrency token still matches then one row will be updated. If the value in the database has changed, then no rows are updated.

UPDATE [Person] SET [Name] = @p1
WHERE [PersonId] = @p0 AND [SocialSecurityNumber] = @p2;








Conventions

By convention, properties are never configured as concurrency tokens.




Data Annotations

You can use the Data Annotations to configure a property as a concurrency token.

	1
2
3
4
5
6
7

	    public class Person
    {
        public int PersonId { get; set; }
        [ConcurrencyCheck]
        public string SocialSecurityNumber { get; set; }
        public string Name { get; set; }
    }










Fluent API

You can use the Fluent API to configure a property as a concurrency token.

	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17
18

	    class MyContext : DbContext
    {
        public DbSet<Person> People { get; set; }

        protected override void OnModelCreating(ModelBuilder modelBuilder)
        {
            modelBuilder.Entity<Person>()
                .Property(p => p.SocialSecurityNumber)
                .IsConcurrencyToken();
        }
    }

    public class Person
    {
        public int PersonId { get; set; }
        public string SocialSecurityNumber { get; set; }
        public string Name { get; set; }
    }










Timestamp/row version

A timestamp is a property where a new value is generated by the database every time a row is inserted or updated. The property is also treated as a concurrency token. This ensures you will get an exception if anyone else has modified a row that you are trying to update since you queried for the data.

How this is achieved is up to the database provider being used. For SQL Server, timestamp is usually used on a byte[] property, which will be setup as a ROWVERSION column in the database.


Conventions

By convention, properties are never configured as timestamps.




Data Annotations

You can use Data Annotations to configure a property as a timestamp.

	1
2
3
4
5
6
7
8

	    public class Blog
    {
        public int BlogId { get; set; }
        public string Url { get; set; }
        
        [Timestamp]
        public byte[] Timestamp { get; set; }
    }










Fluent API

You can use the Fluent API to configure a property as a timestamp.

	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17
18
19

	    class MyContext : DbContext
    {
        public DbSet<Blog> Blogs { get; set; }

        protected override void OnModelCreating(ModelBuilder modelBuilder)
        {
            modelBuilder.Entity<Blog>()
                .Property(p => p.Timestamp)
                .ValueGeneratedOnAddOrUpdate()
                .IsConcurrencyToken();
        }
    }

    public class Blog
    {
        public int BlogId { get; set; }
        public string Url { get; set; }
        public byte[] Timestamp { get; set; }
    }
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Shadow Properties

Shadow properties are properties that do not exist in your entity class. The value and state of these properties is maintained purely in the Change Tracker.

Shadow property values can be obtained and changed through the ChangeTracker API.

context.Entry(myBlog).Property("LastUpdated").CurrentValue = DateTime.Now;





Shadow properties can be referenced in LINQ queries via the EF.Property static method.

var blogs = context.Blogs
    .OrderBy(b => EF.Property<DateTime>(b, "LastUpdated"));






In this article:


	Shadow Properties
	Conventions

	Data Annotations

	Fluent API










Conventions

By convention, shadow properties are only created when a relationship is discovered but no foreign key property is found in the dependent entity class. In this case, a shadow foreign key property will be introduced with the name <principal type name><principal key property name>.

For example, the following code listing will result in a BlogBlogId shadow property being introduced to the Post entity.

	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17
18
19
20
21
22

	    class MyContext : DbContext
    {
        public DbSet<Blog> Blogs { get; set; }
        public DbSet<Post> Posts { get; set; }
    }

    public class Blog
    {
        public int BlogId { get; set; }
        public string Url { get; set; }

        public List<Post> Posts { get; set; }
    }

    public class Post
    {
        public int PostId { get; set; }
        public string Title { get; set; }
        public string Content { get; set; }

        public Blog Blog { get; set; }
    }










Data Annotations

Shadow properties can not be created with data annotations.




Fluent API

You can use the Fluent API to configure shadow properties. Once you have called the string overload of Property you can chain any of the configuration calls you would for other properties.

If the name supplied to the Property method matches the name of an existing property (a shadow property or one defined on the entity class), then the code will configure that existing property rather than introducing a new shadow property.

	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16

	    class MyContext : DbContext
    {
        public DbSet<Blog> Blogs { get; set; }

        protected override void OnModelCreating(ModelBuilder modelBuilder)
        {
            modelBuilder.Entity<Blog>()
                .Property<DateTime>("LastUpdated");
        }
    }

    public class Blog
    {
        public int BlogId { get; set; }
        public string Url { get; set; }
    }
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Relationships

A relationship defines how two entities relate to each other. In a relational database, this is represented by a foreign key constraint.


注解

Most of the samples in this article use a one-to-many relationship to demonstrate concepts. For examples of one-to-one and many-to-many relationships see the Other Relationship Patterns section at the end of the article.




In this article:


	Relationships
	Definition of Terms

	Conventions
	Fully Defined Relationships

	No Foreign Key Property

	Single Navigation Property

	Cascade Delete





	Data Annotations
	[ForeignKey]

	[InverseProperty]





	Fluent API
	Single Navigation Property

	Foreign Key

	Principal Key

	Required

	Cascade Delete





	Other Relationship Patterns
	One-to-one

	Many-to-many














Definition of Terms


	There are a number of terms used to describe relationships

	
	Dependent entity: This is the entity that contains the foreign key property(s). Sometimes referred to as the ‘child’ of the relationship.

	Principal entity: This is the entity that contains the primary/alternate key property(s). Sometimes referred to as the ‘parent’ of the relationship.

	Foreign key: The property(s) in the dependent entity that is used to store the values of the principal key property that the entity is related to.

	Principal key: The property(s) that uniquely identifies the principal entity. This may be the primary key or an alternate key.

	Navigation property: A property defined on the principal and/or dependent entity that contains a reference(s) to the related entity(s).

	Collection navigation property: A navigation property that contains references to many related entities.

	Reference navigation property: A navigation property that holds a reference to a single related entity.

	Inverse navigation property: When discussing a particular navigation property, this term refers to the navigation property on the other end of the relationship.





	The following code listing shows a one-to-many relationship between Blog and Post

	
	Post is the dependent entity

	Blog is the principal entity

	Post.BlogId is the foreign key

	Blog.BlogId is the principal key (in this case it is a primary key rather than an alternate key)

	Post.Blog is a reference navigation property

	Blog.Posts is a collection navigation property

	Post.Blog is the inverse navigation property of Blog.Posts (and vice versa)







	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17

	    public class Blog
    {
        public int BlogId { get; set; }
        public string Url { get; set; }

        public List<Post> Posts { get; set; }
    }

    public class Post
    {
        public int PostId { get; set; }
        public string Title { get; set; }
        public string Content { get; set; }

        public int BlogId { get; set; }
        public Blog Blog { get; set; }
    }










Conventions

By convention, a relationship will be created when there is a navigation property discovered on a type. A property is considered a navigation property if the type it points to can not be mapped as a scalar type by the current database provider.


注解

Relationships that are discovered by convention will always target the primary key of the principal entity. To target an alternate key, additional configuration must be performed using the Fluent API.




Fully Defined Relationships


	The most common pattern for relationships is to have navigation properties defined on both ends of the relationship and a foreign key property defined in dependent entity class.

	
	If a pair of navigation properties is found between two types, then they will be configured as inverse navigation properties of the same relationship.

	If the dependent entity contains a property named <primary key property name>, <navigation property name><primary key property name>, or <principal entity name><primary key property name> then it will be configured as the foreign key.







	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17

	    public class Blog
    {
        public int BlogId { get; set; }
        public string Url { get; set; }

        public List<Post> Posts { get; set; }
    }

    public class Post
    {
        public int PostId { get; set; }
        public string Title { get; set; }
        public string Content { get; set; }

        public int BlogId { get; set; }
        public Blog Blog { get; set; }
    }








警告

If there are multiple navigation properties defined between two types (i.e. more than one distinct pair of navigations that point to each other), then no relationships will be created by convention and you will need to manually configure them to identify how the navigation properties pair up.






No Foreign Key Property

While it is recommended to have a foreign key property defined in the dependent entity class, it is not required. If no foreign key property is found, a shadow foreign key property will be introduced with the name <navigation property name><principal key property name> (see Shadow Properties for more information).

	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16

	    public class Blog
    {
        public int BlogId { get; set; }
        public string Url { get; set; }

        public List<Post> Posts { get; set; }
    }

    public class Post
    {
        public int PostId { get; set; }
        public string Title { get; set; }
        public string Content { get; set; }

        public Blog Blog { get; set; }
    }










Single Navigation Property

Including just one navigation property (no inverse navigation, and no foreign key property) is enough to have a relationship defined by convention. You can also have a single navigation property and a foreign key property.

	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14

	    public class Blog
    {
        public int BlogId { get; set; }
        public string Url { get; set; }

        public List<Post> Posts { get; set; }
    }

    public class Post
    {
        public int PostId { get; set; }
        public string Title { get; set; }
        public string Content { get; set; }
    }










Cascade Delete

By convention, cascade delete will be set to Cascade for required relationships and SetNull for optional relationships. Cascade means dependent entities are also deleted. SetNull means that foreign key properties in dependent entities are set to null.


注解

This cascading behavior is only applied to entities that are being tracked by the context. A corresponding cascade behavior should be setup in the database to ensure data that is not being tracked by the context has the same action applied. If you use EF to create the database, this cascade behavior will be setup for you.








Data Annotations

There are two data annotations that can be used to configure relationships, [ForeignKey] and [InverseProperty].


[ForeignKey]

You can use the Data Annotations to configure which property should be used as the foreign key property for a given relationship. This is typically done when the foreign key property is not discovered by convention.

	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17
18
19

	    public class Blog
    {
        public int BlogId { get; set; }
        public string Url { get; set; }

        public List<Post> Posts { get; set; }
    }

    public class Post
    {
        public int PostId { get; set; }
        public string Title { get; set; }
        public string Content { get; set; }

        public int BlogForeignKey { get; set; }

        [ForeignKey("BlogForeignKey")]
        public Blog Blog { get; set; }
    }








注解

The [ForeignKey] annotation can be placed on either navigation property in the relationship. It does not need to go on the navigation property in the dependent entity class.






[InverseProperty]

You can use the Data Annotations to configure how navigation properties on the dependent and principal entities pair up. This is typically done when there is more than one pair of navigation properties between two entity types.

	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25

	    public class Post
    {
        public int PostId { get; set; }
        public string Title { get; set; }
        public string Content { get; set; }

        public int AuthorUserId { get; set; }
        public User Author { get; set; }

        public int ContributorUserId { get; set; }
        public User Contributor { get; set; }
    }

    public class User
    {
        public string UserId { get; set; }
        public string FirstName { get; set; }
        public string LastName { get; set; }

        [InverseProperty("Author")]
        public List<Post> AuthoredPosts { get; set; }

        [InverseProperty("Contributor")]
        public List<Post> ContributedToPosts { get; set; }
    }












Fluent API

To configure a relationship in the Fluent API, you start by identifying the navigation properties that make up the relationship. HasOne or HasMany identifies the navigation property on the entity type you are beginning the configuration on. You then chain a call to WithOne or WithMany to identify the inverse navigation. HasOne/WithOne are used for reference navigation properties and HasMany/WithMany are used for collection navigation properties.

	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29

	    class MyContext : DbContext
    {
        public DbSet<Blog> Blogs { get; set; }
        public DbSet<Post> Posts { get; set; }

        protected override void OnModelCreating(ModelBuilder modelBuilder)
        {
            modelBuilder.Entity<Post>()
                .HasOne(p => p.Blog)
                .WithMany(b => b.Posts);
        }
    }

    public class Blog
    {
        public int BlogId { get; set; }
        public string Url { get; set; }

        public List<Post> Posts { get; set; }
    }

    public class Post
    {
        public int PostId { get; set; }
        public string Title { get; set; }
        public string Content { get; set; }

        public Blog Blog { get; set; }
    }








Single Navigation Property

If you only have one navigation property then there are parameterless overloads of WithOne and WithMany. This indicates that there is conceptually a reference or collection on the other end of the relationship, but there is no navigation property included in the entity class.

	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27

	    class MyContext : DbContext
    {
        public DbSet<Blog> Blogs { get; set; }
        public DbSet<Post> Posts { get; set; }

        protected override void OnModelCreating(ModelBuilder modelBuilder)
        {
            modelBuilder.Entity<Blog>()
                .HasMany(b => b.Posts)
                .WithOne();
        }
    }

    public class Blog
    {
        public int BlogId { get; set; }
        public string Url { get; set; }

        public List<Post> Posts { get; set; }
    }

    public class Post
    {
        public int PostId { get; set; }
        public string Title { get; set; }
        public string Content { get; set; }
    }










Foreign Key

You can use the Fluent API to configure which property should be used as the foreign key property for a given relationship.

	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31

	    class MyContext : DbContext
    {
        public DbSet<Blog> Blogs { get; set; }
        public DbSet<Post> Posts { get; set; }

        protected override void OnModelCreating(ModelBuilder modelBuilder)
        {
            modelBuilder.Entity<Post>()
                .HasOne(p => p.Blog)
                .WithMany(b => b.Posts)
                .HasForeignKey(p => p.BlogForeignKey);
        }
    }

    public class Blog
    {
        public int BlogId { get; set; }
        public string Url { get; set; }

        public List<Post> Posts { get; set; }
    }

    public class Post
    {
        public int PostId { get; set; }
        public string Title { get; set; }
        public string Content { get; set; }

        public int BlogForeignKey { get; set; }
        public Blog Blog { get; set; }
    }







The following code listing shows how to configure a composite foreign key.

	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
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16
17
18
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25
26
27
28
29
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32
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34
35
36

	    class MyContext : DbContext
    {
        public DbSet<Car> Cars { get; set; }

        protected override void OnModelCreating(ModelBuilder modelBuilder)
        {
            modelBuilder.Entity<Car>()
                .HasKey(c => new { c.State, c.LicensePlate });

            modelBuilder.Entity<RecordOfSale>()
                .HasOne(s => s.Car)
                .WithMany(c => c.SaleHistory)
                .HasForeignKey(s => new { s.CarState, s.CarLicensePlate });
        }
    }

    public class Car
    {
        public string State { get; set; }
        public string LicensePlate { get; set; }
        public string Make { get; set; }
        public string Model { get; set; }

        public List<RecordOfSale> SaleHistory { get; set; }
    }

    public class RecordOfSale
    {
        public int RecordOfSaleId { get; set; }
        public DateTime DateSold { get; set; }
        public decimal Price { get; set; }

        public string CarState { get; set; }
        public string CarLicensePlate { get; set; }
        public Car Car { get; set; }
    }










Principal Key

If you want the foreign key to reference a property other than the primary key, you can use the Fluent API to configure the principal key property for the relationship. The property that you configure as the principal key will automatically be setup as an alternate key (see Alternate Keys for more information).

	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
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12
13
14
15
16
17
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19
20
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22
23
24
25
26
27
28
29
30
31
32
33

	    class MyContext : DbContext
    {
        public DbSet<Car> Cars { get; set; }

        protected override void OnModelCreating(ModelBuilder modelBuilder)
        {
            modelBuilder.Entity<RecordOfSale>()
                .HasOne(s => s.Car)
                .WithMany(c => c.SaleHistory)
                .HasForeignKey(s => s.CarLicensePlate)
                .HasPrincipalKey(c => c.LicensePlate);
        }
    }

    public class Car
    {
        public int CarId { get; set; }
        public string LicensePlate { get; set; }
        public string Make { get; set; }
        public string Model { get; set; }

        public List<RecordOfSale> SaleHistory { get; set; }
    }

    public class RecordOfSale
    {
        public int RecordOfSaleId { get; set; }
        public DateTime DateSold { get; set; }
        public decimal Price { get; set; }

        public string CarLicensePlate { get; set; }
        public Car Car { get; set; }
    }







The following code listing shows how to configure a composite principal key.

	 1
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 3
 4
 5
 6
 7
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25
26
27
28
29
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33
34
35

	    class MyContext : DbContext
    {
        public DbSet<Car> Cars { get; set; }

        protected override void OnModelCreating(ModelBuilder modelBuilder)
        {
            modelBuilder.Entity<RecordOfSale>()
                .HasOne(s => s.Car)
                .WithMany(c => c.SaleHistory)
                .HasForeignKey(s => new { s.CarState, s.CarLicensePlate })
                .HasPrincipalKey(c => new { c.State, c.LicensePlate });
        }
    }

    public class Car
    {
        public int CarId { get; set; }
        public string State { get; set; }
        public string LicensePlate { get; set; }
        public string Make { get; set; }
        public string Model { get; set; }

        public List<RecordOfSale> SaleHistory { get; set; }
    }

    public class RecordOfSale
    {
        public int RecordOfSaleId { get; set; }
        public DateTime DateSold { get; set; }
        public decimal Price { get; set; }

        public string CarState { get; set; }
        public string CarLicensePlate { get; set; }
        public Car Car { get; set; }
    }








警告

The order that you specify principal key properties must match the order they are specified for the foreign key.






Required

You can use the Fluent API to configure whether the relationship is required or optional. Ultimately this controls whether the foreign key property is required or optional. This is most useful when you are using a shadow state foreign key. If you have a foreign key property in your entity class then the requiredness of the relationship is determined based on whether the foreign key property is required or optional (see Required/optional properties for more information).

	 1
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 3
 4
 5
 6
 7
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28
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	    class MyContext : DbContext
    {
        public DbSet<Blog> Blogs { get; set; }
        public DbSet<Post> Posts { get; set; }

        protected override void OnModelCreating(ModelBuilder modelBuilder)
        {
            modelBuilder.Entity<Post>()
                .HasOne(p => p.Blog)
                .WithMany(b => b.Posts)
                .IsRequired();
        }
    }

    public class Blog
    {
        public int BlogId { get; set; }
        public string Url { get; set; }

        public List<Post> Posts { get; set; }
    }

    public class Post
    {
        public int PostId { get; set; }
        public string Title { get; set; }
        public string Content { get; set; }

        public Blog Blog { get; set; }
    }










Cascade Delete

You an use the Fluent API to configure the cascade delete behavior for a given relationship.


	There are three behaviors that control how a delete operation is applied to dependent entities in a relationship when the principal is deleted or the relationship is severed.

	
	Cascade: Dependent entities are also deleted.

	SetNull: The foreign key properties in dependent entities are set to null.

	Restrict: The delete operation is not applied to dependent entities. The dependent entities remain unchanged.








注解

This cascading behavior is only applied to entities that are being tracked by the context. A corresponding cascade behavior should be setup in the database to ensure data that is not being tracked by the context has the same action applied. If you use EF to create the database, this cascade behavior will be setup for you.



	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31

	    class MyContext : DbContext
    {
        public DbSet<Blog> Blogs { get; set; }
        public DbSet<Post> Posts { get; set; }

        protected override void OnModelCreating(ModelBuilder modelBuilder)
        {
            modelBuilder.Entity<Post>()
                .HasOne(p => p.Blog)
                .WithMany(b => b.Posts)
                .OnDelete(DeleteBehavior.Cascade);
        }
    }

    public class Blog
    {
        public int BlogId { get; set; }
        public string Url { get; set; }

        public List<Post> Posts { get; set; }
    }

    public class Post
    {
        public int PostId { get; set; }
        public string Title { get; set; }
        public string Content { get; set; }

        public int? BlogId { get; set; }
        public Blog Blog { get; set; }
    }












Other Relationship Patterns


One-to-one

One to one relationships have a reference navigation property on both sides. They follow the same conventions as one-to-many relationships, but a unique index is introduced on the foreign key property to ensure only one dependent is related to each principal.

	 1
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 3
 4
 5
 6
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 8
 9
10
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	    public class Blog
    {
        public int BlogId { get; set; }
        public string Url { get; set; }

        public BlogImage BlogImage { get; set; }
    }

    public class BlogImage
    {
        public int BlogImageId { get; set; }
        public byte[] Image { get; set; }
        public string Caption { get; set; }

        public int BlogId { get; set; }
        public Blog Blog { get; set; }
    }








注解

EF will chose one of the entities to be the dependent based on its ability to detect a foreign key property. If the wrong entity is chosen as the dependent you can use the Fluent API to correct this.



When configuring the relationship with the Fluent API, you use the HasOne and WithOne methods.

When configuring the foreign key you need to specify the dependent entity type - notice the generic parameter provided to HasForeignKey in the listing below. In a one-to-many relationship it is clear that the entity with the reference navigation is the dependent and the one with the collection is the principal. But this is not so in a one-to-one relationship - hence the need to explicitly define it.

	 1
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 4
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10
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26
27
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29
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31

	    class MyContext : DbContext
    {
        public DbSet<Blog> Blogs { get; set; }
        public DbSet<BlogImage> BlogImages { get; set; }

        protected override void OnModelCreating(ModelBuilder modelBuilder)
        {
            modelBuilder.Entity<Blog>()
                .HasOne(p => p.BlogImage)
                .WithOne(i => i.Blog)
                .HasForeignKey<BlogImage>(b => b.BlogForeignKey);
        }
    }

    public class Blog
    {
        public int BlogId { get; set; }
        public string Url { get; set; }

        public BlogImage BlogImage { get; set; }
    }

    public class BlogImage
    {
        public int BlogImageId { get; set; }
        public byte[] Image { get; set; }
        public string Caption { get; set; }

        public int BlogForeignKey { get; set; }
        public Blog Blog { get; set; }
    }










Many-to-many

Many-to-many relationships without an entity class to represent the join table are not yet supported. However, you can represent a many-to-many relationship by including an entity class for the join table and mapping two separate one-to-many relationships.

	 1
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 3
 4
 5
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34
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37
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46

	    class MyContext : DbContext
    {
        public DbSet<Post> Posts { get; set; }
        public DbSet<Tag> Tags { get; set; }

        protected override void OnModelCreating(ModelBuilder modelBuilder)
        {
            modelBuilder.Entity<PostTag>()
                .HasKey(t => new { t.PostId, t.TagId });

            modelBuilder.Entity<PostTag>()
                .HasOne(pt => pt.Post)
                .WithMany(p => p.PostTags)
                .HasForeignKey(pt => pt.PostId);

            modelBuilder.Entity<PostTag>()
                .HasOne(pt => pt.Tag)
                .WithMany(t => t.PostTags)
                .HasForeignKey(pt => pt.TagId);
        }
    }

    public class Post
    {
        public int PostId { get; set; }
        public string Title { get; set; }
        public string Content { get; set; }

        public List<PostTag> PostTags { get; set; }
    }

    public class Tag
    {
        public string TagId { get; set; }

        public List<PostTag> PostTags { get; set; }
    }

    public class PostTag
    {
        public int PostId { get; set; }
        public Post Post { get; set; }

        public string TagId { get; set; }
        public Tag Tag { get; set; }
    }
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注解
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Indexes

Indexes are a common concept across many data stores. While their implementation in the data store may vary, they are used to make lookups based on a column (or set of columns) more efficient.


In this article:


	Indexes
	Conventions

	Data Annotations

	Fluent API










Conventions

By convention, an index is created in each property (or set of properties) that are used as a foreign key.




Data Annotations

Indexes can not be created using data annotations.




Fluent API

You can use the Fluent API specify an index on a single property. By default, indexes are non-unique.

	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
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14
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16

	    class MyContext : DbContext
    {
        public DbSet<Blog> Blogs { get; set; }

        protected override void OnModelCreating(ModelBuilder modelBuilder)
        {
            modelBuilder.Entity<Blog>()
                .HasIndex(b => b.Url);
        }
    }

    public class Blog
    {
        public int BlogId { get; set; }
        public string Url { get; set; }
    }







You can also specify that an index should be unique, meaning that no two entities can have the same value(s) for the given property(s).

	1
2
3

	            modelBuilder.Entity<Blog>()
                .HasIndex(b => b.Url)
                .IsUnique();







You can also specify an index over more than one column.
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	    class MyContext : DbContext
    {
        public DbSet<Person> People { get; set; }

        protected override void OnModelCreating(ModelBuilder modelBuilder)
        {
            modelBuilder.Entity<Person>()
                .HasIndex(p => new { p.FirstName, p.LastName });
        }
    }

    public class Person
    {
        public int PersonId { get; set; }
        public string FirstName { get; set; }
        public string LastName { get; set; }
    }








注解

There is only one index per distinct set of properties. If you use the Fluent API to configure an index on a set of properties that already has an index defined, either by convention or previous configuration, then you will be changing the definition of that index. This is useful if you want to further configure an index that was created by convention.
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Alternate Keys

An alternate key serves as a alternate unique identifier for each entity instance in addition to the primary key. When using a relational database this maps to the concept of a unique index/constraint. In EF, alternate keys provide greater functionality than unique Indexes because they can be used as the target of a foreign key.

Alternate keys are typically introduced for you when needed and you do not need to manually configure them. See Conventions for more details.


In this article:


	Alternate Keys
	Conventions

	Data Annotations

	Fluent API










Conventions

By convention, an alternate key is introduced for you when you identify a property, that is not the primary key, as the target of a relationship.
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	    class MyContext : DbContext
    {
        public DbSet<Blog> Blogs { get; set; }
        public DbSet<Post> Posts { get; set; }

        protected override void OnModelCreating(ModelBuilder modelBuilder)
        {
            modelBuilder.Entity<Post>()
                .HasOne(p => p.Blog)
                .WithMany(b => b.Posts)
                .HasForeignKey(p => p.BlogUrl)
                .HasPrincipalKey(b => b.Url);
        }
    }

    public class Blog
    {
        public int BlogId { get; set; }
        public string Url { get; set; }

        public List<Post> Posts { get; set; }
    }

    public class Post
    {
        public int PostId { get; set; }
        public string Title { get; set; }
        public string Content { get; set; }

        public string BlogUrl { get; set; }
        public Blog Blog { get; set; }
    }










Data Annotations

Alternate keys can not be configured using Data Annotations.




Fluent API

You can use the Fluent API to configure a single property to be an alternate key.
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	    class MyContext : DbContext
    {
        public DbSet<Car> Cars { get; set; }

        protected override void OnModelCreating(ModelBuilder modelBuilder)
        {
            modelBuilder.Entity<Car>()
                .HasAlternateKey(c => c.LicensePlate);
        }
    }

    class Car
    {
        public int CarId { get; set; }
        public string LicensePlate { get; set; }
        public string Make { get; set; }
        public string Model { get; set; }
    }







You can also use the Fluent API to configure multiple properties to be an alternate key (known as a composite alternate key).
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	    class MyContext : DbContext
    {
        public DbSet<Car> Cars { get; set; }

        protected override void OnModelCreating(ModelBuilder modelBuilder)
        {
            modelBuilder.Entity<Car>()
                .HasAlternateKey(c => new { c.State, c.LicensePlate });
        }
    }

    class Car
    {
        public int CarId { get; set; }
        public string State { get; set; }
        public string LicensePlate { get; set; }
        public string Make { get; set; }
        public string Model { get; set; }
    }
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Inheritance

Inheritance in the EF model is used to control how inheritance in the entity classes is represented in the database.


In this article:


	Inheritance
	Conventions

	Data Annotations

	Fluent API










Conventions

By convention, it is up to the database provider to determine how inheritance will be represented in the database. See Inheritance (Relational Database) for how this is handled with a relational database provider.

EF will only setup inheritance if two or more inherited types are explicitly included in the model. EF will not scan for base or derived types that were not otherwise included in the model. You can include types in the model by exposing a DbSet<TEntity> for each type in the inheritance hierarchy.

	 1
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	    class MyContext : DbContext
    {
        public DbSet<Blog> Blogs { get; set; }
        public DbSet<RssBlog> RssBlogs { get; set; }
    }

    public class Blog
    {
        public int BlogId { get; set; }
        public string Url { get; set; }
    }

    public class RssBlog : Blog
    {
        public string RssUrl { get; set; }
    }







If you don’t want to expose a DbSet<TEntity> for one or more entities in the hierarchy, you can use the Fluent API to ensure they are included in the model.

	1
2
3
4
5
6
7
8
9

	    class MyContext : DbContext
    {
        public DbSet<Blog> Blogs { get; set; }

        protected override void OnModelCreating(ModelBuilder modelBuilder)
        {
            modelBuilder.Entity<RssBlog>();
        }
    }










Data Annotations

You cannot use Data Annotations to configure inheritance.




Fluent API

The Fluent API for inheritance depends on the database provider you are using. See Inheritance (Relational Database) for the configuration you can perform for a relational database provider.
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Relational Database Modeling

This section covers aspects of modeling that are specific to relational databases.



	Table Mapping

	Column Mapping

	Data Types

	Primary Keys

	Default Schema

	Computed Columns

	Sequences

	Default Values

	Indexes

	Foreign Key Constraints

	Alternate Keys (Unique Constraints)

	Inheritance (Relational Database)
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注解

The configuration in this section is applicable to relational databases in general. The extension methods shown here will become available when you install a relational database provider (due to the shared EntityFramework.Relational package).




Table Mapping

Table mapping identifies which table data should be queried from and saved to in the database.


In this article:


	Table Mapping
	Conventions

	Data Annotations

	Fluent API










Conventions

By convention, each entity will be setup to map to a table with the same name as the entity.




Data Annotations

You can use Data Annotations to configure the table that a type maps to.

	1
2
3
4
5
6

	    [Table("blogs")]
    public class Blog
    {
        public int BlogId { get; set; }
        public string Url { get; set; }
    }







You can also specify a schema that the table belongs to.

	1
2
3
4
5
6

	    [Table("blogs", Schema = "blogging")]
    public class Blog
    {
        public int BlogId { get; set; }
        public string Url { get; set; }
    }










Fluent API

You can use the Fluent API to configure the table that a type maps to.

	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16

	    class MyContext : DbContext
    {
        public DbSet<Blog> Blogs { get; set; }

        protected override void OnModelCreating(ModelBuilder modelBuilder)
        {
            modelBuilder.Entity<Blog>()
                .ToTable("blogs");
        }
    }

    public class Blog
    {
        public int BlogId { get; set; }
        public string Url { get; set; }
    }







You can also specify a schema that the table belongs to.

	1
2

	            modelBuilder.Entity<Blog>()
                .ToTable("blogs", schema: "blogging");
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注解

The configuration in this section is applicable to relational databases in general. The extension methods shown here will become available when you install a relational database provider (due to the shared EntityFramework.Relational package).




Column Mapping

Column mapping identifies which column data should be queried from and saved to in the database.


In this article:


	Column Mapping
	Conventions

	Data Annotations

	Fluent API










Conventions

By convention, each property will be setup to map to a column with the same name as the property.




Data Annotations

You can use Data Annotations to configure the column to which a property is mapped.

	1
2
3
4
5
6

	    public class Blog
    {
        [Column("blog_id")]
        public int BlogId { get; set; }
        public string Url { get; set; }
    }










Fluent API

You can use the Fluent API to configure the column to which a property is mapped.

	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17

	    class MyContext : DbContext
    {
        public DbSet<Blog> Blogs { get; set; }

        protected override void OnModelCreating(ModelBuilder modelBuilder)
        {
            modelBuilder.Entity<Blog>()
                .Property(b => b.BlogId)
                .HasColumnName("blog_id");
        }
    }

    public class Blog
    {
        public int BlogId { get; set; }
        public string Url { get; set; }
    }
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注解

The configuration in this section is applicable to relational databases in general. The extension methods shown here will become available when you install a relational database provider (due to the shared EntityFramework.Relational package).




Data Types

Data type refers to the database specific type of the column to which a property is mapped.


In this article:


	Data Types
	Conventions

	Data Annotations

	Fluent API










Conventions

By convention, the database provider selects a data type based on the CLR type of the property. It also takes into account other metadata, such as the configured Maximum Length, whether the property is part of a primary key, etc.

For example, SQL Server uses datetime2(7) for DateTime properties, and nvarchar(max) for string properties (or nvarchar(450) for string properties that are used as a key).




Data Annotations

You can use Data Annotations to specify an exact data type for the column.

	1
2
3
4
5
6

	    public class Blog
    {
        public int BlogId { get; set; }
        [Column(TypeName = "varchar(200)")]
        public string Url { get; set; }
    }










Fluent API

You can use the Fluent API to specify an exact data type for the column.

	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17

	    class MyContext : DbContext
    {
        public DbSet<Blog> Blogs { get; set; }

        protected override void OnModelCreating(ModelBuilder modelBuilder)
        {
            modelBuilder.Entity<Blog>()
                .Property(b => b.Url)
                .HasColumnType("varchar(200)");
        }
    }

    public class Blog
    {
        public int BlogId { get; set; }
        public string Url { get; set; }
    }







If you are targeting more than one relational provider with the same model then you probably want to specify a data type for each provider rather than a global one to be used for all relational providers.

	1
2
3

	            modelBuilder.Entity<Blog>()
                .Property(b => b.Url)
                .ForSqlServerHasColumnType("varchar(200)");
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注解

The configuration in this section is applicable to relational databases in general. The extension methods shown here will become available when you install a relational database provider (due to the shared EntityFramework.Relational package).




Primary Keys

A primary key constraint is introduced for the key of each entity type.


Conventions

By convention, the primary key in the database will be named PK_<type name>.




Data Annotations

No relational database specific aspects of a primary key can be configured using Data Annotations.




Fluent API

You can use the Fluent API to configure the name of the primary key constraint in the database.

	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17

	    class MyContext : DbContext
    {
        public DbSet<Blog> Blogs { get; set; }

        protected override void OnModelCreating(ModelBuilder modelBuilder)
        {
            modelBuilder.Entity<Blog>()
                .HasKey(b => b.BlogId)
                .HasName("PrimaryKey_BlogId");
        }
    }

    public class Blog
    {
        public int BlogId { get; set; }
        public string Url { get; set; }
    }
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注解

The configuration in this section is applicable to relational databases in general. The extension methods shown here will become available when you install a relational database provider (due to the shared EntityFramework.Relational package).




Default Schema

The default schema is the database schema that objects will be created in if a schema is not explicitly configured for that object.


Conventions

By convention, the database provider will chose the most appropriate default schema. For example, Microsoft SQL Server will use the dbo schema and SQLite will not use a schema (since schemas are not supported in SQLite).




Data Annotations

You can not set the default schema using Data Annotations.




Fluent API

You can use the Fluent API to specify a default schema.

	1
2
3
4
5
6
7
8
9

	    class MyContext : DbContext
    {
        public DbSet<Blog> Blogs { get; set; }

        protected override void OnModelCreating(ModelBuilder modelBuilder)
        {
            modelBuilder.HasDefaultSchema("blogging");
        }
    }
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注解

The configuration in this section is applicable to relational databases in general. The extension methods shown here will become available when you install a relational database provider (due to the shared EntityFramework.Relational package).




Computed Columns

A computed column is a column whose value is calculated in the database. A computed column can use other columns in the table to calculate its value.


Conventions

By convention, computed columns are not created in the model.




Data Annotations

Computed columns can not be configured with Data Annotations.




Fluent API

You can use the Fluent API to specify that a property should map to a computed column.

	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17
18
19

	    class MyContext : DbContext
    {
        public DbSet<Person> People { get; set; }

        protected override void OnModelCreating(ModelBuilder modelBuilder)
        {
            modelBuilder.Entity<Person>()
                .Property(p => p.DisplayName)
                .HasComputedColumnSql("[LastName] + ', ' + [FirstName]");
        }
    }

    public class Person
    {
        public int PersonId { get; set; }
        public string FirstName { get; set; }
        public string LastName { get; set; }
        public string DisplayName { get; set; }
    }
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注解

The configuration in this section is applicable to relational databases in general. The extension methods shown here will become available when you install a relational database provider (due to the shared EntityFramework.Relational package).




Sequences

A sequence generates a sequential numeric values in the database. Sequences are not associated with a specific table.


Conventions

By convention, sequences are not introduced in to the model.




Data Annotations

You can not configure a sequence using Data Annotations.




Fluent API

You can use the Fluent API to create a sequence in the model.

	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11

	    class MyContext : DbContext
    {
        public DbSet<Order> Orders { get; set; }

        protected override void OnModelCreating(ModelBuilder modelBuilder)
        {
            modelBuilder.HasSequence<int>("OrderNumbers");
        }
    }

    public class Order







You can also configure additional aspect of the sequence, such as its schema, start value, and increment.

	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11

	    class MyContext : DbContext
    {
        public DbSet<Order> Orders { get; set; }

        protected override void OnModelCreating(ModelBuilder modelBuilder)
        {
            modelBuilder.HasSequence<int>("OrderNumbers", schema: "shared")
                .StartsAt(1000)
                .IncrementsBy(5);
        }
    }







Once a sequence is introduced, you can use it to generate values for properties in your model. For example, you can use Default Values to insert the next value from the sequence.

	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17
18
19
20
21
22

	    class MyContext : DbContext
    {
        public DbSet<Order> Orders { get; set; }

        protected override void OnModelCreating(ModelBuilder modelBuilder)
        {
            modelBuilder.HasSequence<int>("OrderNumbers", schema: "shared")
                .StartsAt(1000)
                .IncrementsBy(5);

            modelBuilder.Entity<Order>()
                .Property(o => o.OrderNo)
                .HasDefaultValueSql("NEXT VALUE FOR shared.OrderNumbers");
        }
    }

    public class Order
    {
        public int OrderId { get; set; }
        public int OrderNo { get; set; }
        public string Url { get; set; }
    }
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注解

The configuration in this section is applicable to relational databases in general. The extension methods shown here will become available when you install a relational database provider (due to the shared EntityFramework.Relational package).




Default Values

The default value of a column is the value that will be inserted if a new row is inserted but no value is specified for the column.


Conventions

By convention, a default value is not configured.




Data Annotations

You can not set a default value using Data Annotations.




Fluent API

You can use the Fluent API to specify the default value for a property.

	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17
18

	    class MyContext : DbContext
    {
        public DbSet<Blog> Blogs { get; set; }

        protected override void OnModelCreating(ModelBuilder modelBuilder)
        {
            modelBuilder.Entity<Blog>()
                .Property(b => b.Rating)
                .HasDefaultValue(3);
        }
    }

    public class Blog
    {
        public int BlogId { get; set; }
        public string Url { get; set; }
        public int Rating { get; set; }
    }







You can also specify a SQL fragment that is used to calculate the default value.

	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17
18

	    class MyContext : DbContext
    {
        public DbSet<Blog> Blogs { get; set; }

        protected override void OnModelCreating(ModelBuilder modelBuilder)
        {
            modelBuilder.Entity<Blog>()
                .Property(b => b.Created)
                .HasDefaultValueSql("getdate()");
        }
    }

    public class Blog
    {
        public int BlogId { get; set; }
        public string Url { get; set; }
        public DateTime Created { get; set; }
    }
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注解

The configuration in this section is applicable to relational databases in general. The extension methods shown here will become available when you install a relational database provider (due to the shared EntityFramework.Relational package).




Indexes

An index in a relational database maps to the same concept as an index in the core of Entity Framework.


Conventions

By convention, indexes are named IX_<type name>_<property name>. For composite indexes <property name> becomes an underscore separated list of property names.




Data Annotations

Indexes can not be configured using Data Annotations.




Fluent API

You can use the Fluent API to configure the name of an index.

	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17

	    class MyContext : DbContext
    {
        public DbSet<Blog> Blogs { get; set; }

        protected override void OnModelCreating(ModelBuilder modelBuilder)
        {
            modelBuilder.Entity<Blog>()
                .HasIndex(b => b.Url)
                .HasName("Index_Url");
        }
    }

    public class Blog
    {
        public int BlogId { get; set; }
        public string Url { get; set; }
    }
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注解

The configuration in this section is applicable to relational databases in general. The extension methods shown here will become available when you install a relational database provider (due to the shared EntityFramework.Relational package).




Foreign Key Constraints

A foreign key constraint is introduced for each relationship in the model.


Conventions

By convention, foreign key constraints are named FK_<dependent type name>_<principal type name>_<foreign key property name>. For composite foreign keys <foreign key property name> becomes an underscore separated list of foreign key property names.




Data Annotations

Foreign key constraint names cannot be configured using data annotations.




Fluent API

You can use the Fluent API to configure the foreign key constraint name for a relationship.

	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31

	    class MyContext : DbContext
    {
        public DbSet<Blog> Blogs { get; set; }
        public DbSet<Post> Posts { get; set; }

        protected override void OnModelCreating(ModelBuilder modelBuilder)
        {
            modelBuilder.Entity<Post>()
                .HasOne(p => p.Blog)
                .WithMany(b => b.Posts)
                .HasForeignKey(p => p.BlogId)
                .HasConstraintName("ForeignKey_Post_Blog");
        }
    }

    public class Blog
    {
        public int BlogId { get; set; }
        public string Url { get; set; }

        public List<Post> Posts { get; set; }
    }

    public class Post
    {
        public int PostId { get; set; }
        public string Title { get; set; }
        public string Content { get; set; }

        public int BlogId { get; set; }
        public Blog Blog { get; set; }
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注解

The configuration in this section is applicable to relational databases in general. The extension methods shown here will become available when you install a relational database provider (due to the shared EntityFramework.Relational package).




Alternate Keys (Unique Constraints)

A unique constraint is introduced for each alternate key in the model.


Conventions

By convention, the index and constraint that are introduced for an alternate key will be named AK_<type name>_<property name>. For composite alternate keys <property name> becomes an underscore separated list of property names.




Data Annotations

Unique constraints can not be configured using Data Annotations.




Fluent API

You can use the Fluent API to configure the index and constraint name for an alternate key.

	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17
18

	    class MyContext : DbContext
    {
        public DbSet<Car> Cars { get; set; }

        protected override void OnModelCreating(ModelBuilder modelBuilder)
        {
            modelBuilder.Entity<Car>()
                .HasAlternateKey(c => c.LicensePlate)
                .HasName("AlteranteKey_LicensePlate");
        }
    }

    class Car
    {
        public int CarId { get; set; }
        public string LicensePlate { get; set; }
        public string Make { get; set; }
        public string Model { get; set; }
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注解

The configuration in this section is applicable to relational databases in general. The extension methods shown here will become available when you install a relational database provider (due to the shared EntityFramework.Relational package).




Inheritance (Relational Database)

Inheritance in the EF model is used to control how inheritance in the entity classes is represented in the database.


In this article:


	Inheritance (Relational Database)
	Conventions

	Data Annotations

	Fluent API










Conventions

By convention, inheritance will be mapped using the table-per-hierarchy (TPH) pattern. TPH uses a single table to store the data for all types in the hierarchy. A discriminator column is used to identify which type each row represents.

EF will only setup inheritance if two or more inherited types are explicitly included in the model (see Inheritance for more details).

Below is an example showing a simple inheritance scenario and the data stored in a relational database table using the TPH pattern. The Discriminator column identifies which type of Blog is stored in each row.

	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16

	    class MyContext : DbContext
    {
        public DbSet<Blog> Blogs { get; set; }
        public DbSet<RssBlog> RssBlogs { get; set; }
    }

    public class Blog
    {
        public int BlogId { get; set; }
        public string Url { get; set; }
    }

    public class RssBlog : Blog
    {
        public string RssUrl { get; set; }
    }







[image: ../../_images/inheritance-tph-data.png]



Data Annotations

You cannot use Data Annotations to configure inheritance.




Fluent API

You can use the Fluent API to configure the name and type of the discriminator column and the values that are used to identify each type in the hierarchy.

	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17
18
19
20
21
22
23

	    class MyContext : DbContext
    {
        public DbSet<Blog> Blogs { get; set; }

        protected override void OnModelCreating(ModelBuilder modelBuilder)
        {
            modelBuilder.Entity<Blog>()
                .HasDiscriminator<string>("blog_type")
                .HasValue<Blog>("blog_base")
                .HasValue<RssBlog>("blog_rss");
        }
    }

    public class Blog
    {
        public int BlogId { get; set; }
        public string Url { get; set; }
    }

    public class RssBlog : Blog
    {
        public string RssUrl { get; set; }
    }
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